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Intoroduction

Operating
environment

Computer
Personal computer running Windows 95, Windows 98, or Win-
dows NT® 4.0

CPU
If you're using Windows 95:

1486SX or better (Pentium 100 MHz recommended)
If you're using Windows 98 or Windows NT 4.0:

1486DX or better (Pentium 100 MHz recommended)

System Memory
If you're using Windows 95:

8 MB or more (10 MB or more recommended)
If you're using Windows 98 or Windows NT 4.0:

16 MB or more (32 MB or more recommended)

Hard Disk

10 MB or more of free space

Overview of
Dr.Engrave

Dr. Engrave is a program for plate engraving that runs under
Windows 95/98/NT.

Main Features of Dr. Engrave

- Support for multiple plates
You can arrange a number of plates with the same design
within the engraver’s cutting area. This makes it possible to
make many plates efficiently.
You can make a master plate, then make the settings for the
number of plates laid out and their spacing. You can also
divide a single plate.

Import text files

Text files with comma- or tab-separated values can be
imported into text boxes. This lets you make use of files made
using a spreadsheet or a database that can export data in text
format.

Fill feature
Flat-drag machining can be performed for the center of text
and graphics.

Image contouring

Image contours can be extracted and converted to line
segments.

Images can be entered by importing them from a TWAIN-
compliant image scanner connected to the host computer, or
by importing an image file saved in bitmap (BMP) format.
You can also register a converted graphic as a symbol.

Generation of stroke characters

Characters with no line width (i.e., stroke characters) can be
generated automatically from TrueType font characters. You
can use such generated stroke fonts in Dr. Engrave in the same
way as other fonts registered with Windows. (However, you
can’t use them with other programs.)

Text that has been changed to stroke characters can be
engraved more rapidly than outline fonts, because the
characters are made up of fewer line segments.

You can also clean up such automatically generated stroke
characters (stroke-character edit function).

- You can extract and display the contours of characters (for
TrueType fonts).

- You can set characters (TrueType fonts) to the desired width
(weight).

- You can create rectangles, circles, stars, polygons (polyline),
and other graphics.

- Objects can be positioned with precision (snap-to-grid
feature).
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Starting the software

1.

Click [Start].
Point to [Roland Dr.Engrave] and click [Dr.Engrave].

Accessonies L4 |
nd Dr.Engr

Documents 4 StartlJp 4 @ Dr.Engrave Help
M5-D0S5 P k uninztall
I% Setting: 4 ﬂ e a
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1) Q] End 8
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The opening screen appears and Dr.Engrave starts.

*Untitled - Di.Engrave

E=Roland

)\

Cursor pos. [1.719, 0,763 Dbject center | Dimersion Angle Slant ‘
Feady 100% NUM




Intoroduction

Names and functions of screen items
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(1) Title bar
The file name and program name are displayed here.
The window can be moved by dragging the title bar.

(2) Menu Bar

Runs the various commands for Dr.Engrave.

(3) Toolbar

The toolbar is provided with buttons for running Dr.Engrave
commands such as [Open...] and [Save]. Moving the mouse
pointer over a button displays a brief description of the button’s
function.

(4) Engraving area

This white square shows the engraving area (cutting area) set with
the driver.

An object that protrudes beyond this area is not engraved.

The lower-left point of the engraving area is the origin point for
Dr. Engrave, which coincides with the XY origin (home position)
of the engraving machine.

(5) Origin point

This point (the lower-left point of the engraving area), is the origin
point for Dr. Engrave.

This coincides with the XY origin (home position) for the
engraving machine.

(6) Object Information Bar

This shows the location of the mouse pointer, as well as the
centerpoint, size, angle, and slant of the object.

This doesn’t appear when more than one plate is laid out.

Corsyet o Polegon

(7) Status Bar

This shows Dr. Engrave’s state of operation and provides brief
descriptions of commands.

This also shows line color and amount of zoom in or zoom out for
the image.

(8) Object

This is a shape or a block of text to be engrave.

(9) Popup menu

Clicking the right mouse button within an editing area makes a
menu appear.

The displayed menu varies according to the type of selected object
or present mode.

(10)

When the mouse pointer is moved close to here, the pointer
changes to a diagonal arrow. You can then change the window
size by dragging.

(11) Minimize button
This shrinks the window to a button on the taskbar.

(12) Maximize button
This expands the window to fill the screen.

(13) Close button

This ends the program.

If changes made to the file being edited have not been saved, a
dialog box asking if you wish to save the changes is displayed.
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1 Operation Procedures

Introduction

This section explains the basic operation of Dr. Engrave, taking
the engraving of the plate shown in the figure as an example to
describe each step.

IRolend

Rolbert

|*— B0 mim —~|

(2.4 inch)

40 mm
(1.5 inch)

Step 1: Enter the

workpiece
size

Set the engraving area to match the size of the workpiece loaded.
The engraving range that has been set becomes the editing area for
Dr. Engrave. The editing area is represented by a shadowed white
rectangle.

A plate is designed by arranging shapes and text in the editing
area. Portions that extend beyond this area are not engrave.

1.

2.

From the [File] menu, click [Print Setup...].

The [Print Setup] dialog box is displayed.

For [Printer], click [Name], then choose the driver to be used
for output.

Marme: IFh:uIand CAkdhd-2 PMC-23004 ﬂ Properties |

Click [Properties].

The driver's properties open.

Enter the cutting area (engraving area).

In this example, enter a range with vertical size of 40 mm and
a horizontal size of 60 mm.

whidth [eoo 4

Length - 400 :I

Leave the Properties screen displayed and carry out the next
steps.
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Step 2: Set the
cutting
conditions

Make the settings for the blade's movement speed, cutting-in
amount, and other cutting conditions to match the composition and
thickness of the loaded workpiece and the type of blade.

For cutting conditions such as Z0 that can't be set with the driver,
make the settings directly on the engraving machine.

This section gives an overview of the steps when engraving all
graphics and text at the same depth. For more details about the
cutting-condition settings, see the help screens for the driver.

1. At the driver's Properties, click the [Tool] tab.
Enter the feed rate for [X/Y Speed] and [Z Speed].

=57 Speed £ Speed

I2 :|I [rorniz] I2 j [rrimn=]

When the feeding speed is high, processing becomes rough
and flash marks tend to remain on the cut surface. On the other
hand, when the feeding speed is slow, processing takes more
time.
Be careful because a slower feeding speed does not always
result in improved finishing.
Set a feed rate that is optimal for the composition of the
workpiece being engraved as well as the composition and
diameter of the blade.

3. Enter the values for [Z Up Position] and [Z Down Position].
The figure below shows a case where Z0 is set at the
workpiece surface.

Z Up Poszition : Cutter

[100 = fom] ZUp

Position {ZE}—T—
20—

Z Down —— Warkpiece

FPaosition 1)

£ Down Pozition ;

[050 = o

4. Enter the value for [Z Engraving Pitch].

£ Enaraving Fitch : First cutting path
020 = [mm] _j[aecnnd path

..... H=L— | astpath
Warkpiece

When the cutting-in amount is deeper, the cutting speed
increases, but the cutting-in amount is limited by the quality of
the workpiece. In cases where the required depth can not be
cut at once, repeat cutting several times to depth that does not
breach the limit.

5. Click [OK].
The click [OK] again to close the [Print Setup] dialog box.

Step 3: Enter the text

Enter the block of text to be engraved.

The text that is input is displayed as outlined text. Dr. Engrave can
use TrueType fonts registered with Windows as well as stroke
fonts that you create yourself.

Here we'll input Robert as the block of text and set Times New
Roman.

1. Click the button.
The mouse pointer changes to the cursor for the text-editing

tool ( ).

Click at the start point for entering the text.
Type in Robert from the keyboard.

Click the button.

vk we

From the [Format] menu, click [Font...].

The [Font Select] dialog box is displayed.

6. Click on the font name to select it and click [OK].
Here, we'll select Times New Roman.

7. Drag one of the points () around the text string to change
the size of the text string.
To enlarge or reduce the size of the text string at a uniform
scale, hold down the [Shift] key while dragging.

8. Drag the text string to position it at the desired location.

In this example, the text string is positioned as shown the

figure.

Rolberrt

10
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Step 4: Draw graphics

Add graphics to the data. In this example we'll draw a narrow
rectangle.

In addition to regular rectangles, Dr. Engrave can draw rounded-
corner rectangles, circles and ellipses, stars, and polygons
(polyline).

1. Click the button.
The mouse pointer changes from the selection tool () to the

shape-drawing tool ().
2. Drag the pointer as shown in the figure.

/
[Robert

J,,—Drag start point

jLi Drag end point

Step 5: Import an
iImage file

You can import existing image data, extract the contours, and
convert the data to line segments.

For instance, it's possible to include the logo data for a company
or organization in a plate.

This section explains the steps in converting an image file you've
already acquired with a scanner (in Windows bitmap format) to
line segments.

1. From the [File] menu, click [Import...].
The [Open] dialog box appears.

2. Click [Files of type] and select [Windows Bitmap File
(*.bmp)].
A list of files that can be imported is shown.

Files of type:  [windows Bitmap File [~ bmp] =|

3. Select the desired file and click [Open].

4. The data is read into the preview screen and displayed. Check
the contents and click [OK].
When importing a color image, outlining may not proceed as
expected, depending on the colors. In such cases, drag the
[Adjust Image Density] slider to adjust the image, or refer to
the "Importing bitmap data " to correct the data using a
commercial software application.

5. The outlined object appears on screen.

___Rclenae

Robert

6. Click the button.

. Click on the object to select it.
8. Drag one of the points () around the object to change the
size of the object.
To enlarge or reduce the size of the object at a uniform scale,
hold down the [Shift] key while dragging.
9. Drag the object to position it at the desired location.
In this example, the object is positioned as shown the figure.

—IRolend

Robert

11
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Step 6: Save the file

Save the data that's been created to a file.

1. Click the button.

The [Save As] dialog box appears.
2. Specify where to save the file.
3. Enter the name of the file and click [Save].

Step 7: Start

engraving

Output the data and start engraving.

Before starting engraving, check the cable connections, the loaded
position of the workpiece, the installed blade, and the setting for
the origin. For more information, take a look at the user's manual
for the engraving machine.

Click the button.

The [Print] dialog box appears.

Click [OK].

The engraving data is sent to the engraving machine, and
engraving starts.

To cancel engraving before it's finished

1.

ek wn

Pause the engraving machine.

For more information, take a look at the user's manual for the
engraving machine.

On the Windows, click [Start].

Point to [Settings] and click [Printers].

Double-click the icon for the printer driver.

From the [Printer] menu, click [Purge Print Jobs].

The file being engraved is deleted from the list. If the file
being engraved isn't shown, it means that the sending of data
has already ended.

Operate the engraving machine to end the task.

For more information, take a look at the user's manual for the
engraving machine.

12



2

Basic Operations
for Objects




2 Basic Operations for Object

Selecting an object
1. Click the [ & ] button.

2. Move the mouse cursor to the object to be selected, and click
the mouse.

3. The symbols M and A appear around the selected object.
When an object is chosen, pressing the [Tab] key selects a

different object. To invert the object selection order, hold
down the [Shift] key and press [Tab].

Selecting more than object
- While holding down the [Shift] key, click on each of the
objects you wish to select.
- Drag the mouse to enclose entirely the object you wish to
select.

Canceling the
selection of an
object

1. Click the III button.

2. Click on an area other than the selected object.

Moving an object
horizontally or
vertically

1. Click the III button.

2. Click on the object to select it.
3. While holding down the [Shift] key, drag the object up, down,
or to the left or right.

Making an object
larger or smaller

1. Click the E button.

2. Click on the object to select it.
3. Change the size of the object by dragging the points ( M and
A ) that appear around the object.

The size can be freely changed by dragging a square point ( Il
)

The size can be changed while maintaining the shape's vertical
and horizontal aspect by holding down the [Shift] key while
dragging.

The triangular points ( A ) on the left and right can be dragged
to change the horizontal size.

The triangular points ( A ) above and below can be dragged to
change the vertical size.

Rotating an object
1. Click the [ & ] bution.

2. Click on the object to select it.
3. Click on the object again.

The circular points ( @ ) appear around the object.
4. Drag a circular point ( @ ) to rotate the object.

-

14



2 Basic Operations for Object

Slanting an object

* Text boxes cannot be slanted.

Click the |E| button.

2. Click on the object to select it.
3. Click on the object again.

The diamond point ( ) appears.

In the case of a text string, a slant bar appears.
4. Drag a diamond point ( 4 ) to slant the object.

-

For a text string, drag one of the points ( 4 ) for the slant bar.

o * o ®
ABCr = ABC™
QQ!Q QA]’QQ

Slant bar

Copying an object
Click the [ & ] button,

2. Select the object to be copied by clicking on it.

3. Click the button.

4. Click the

The new object is copied overlapping the source object.

5. Select the copied object and drag it to the desired location.

Deleting an object

1. Click the E button.

2. Select the object to be deleted by clicking on it.
3. From the [Edit] menu, click [Delete].

Selecting a vertex of
a polygon (polyline)
Click the [ fig | button.

2. Click on the polygon (polyline).

3. Click on the point.
The selected point changes to a square with a border (@] ).
When a vertex is chosen, pressing the [Tab] key selects a
different vertex. To invert the vertex selection order, hold
down the [Shift] key and press [Tab].

Selecting multiple
vertices of a polygon

(polyline)
. Click the [fix| button.

2. Click on the polygon (polyline).

3. Hold down the [Shift] key and click on each point ().
Alternatively, drag the mouse over the points to be selected.
Each selected point changes to a square with a border ( W] ).

15



2 Basic Operations for Object

Selecting all vertices
of a polygon

(polyline)
1. Click the [fi] button.

2. Click on the polygon (polyline).

3. While holding down the [Ctrl] key, click on one point ().
All vertices contained in the polygon (polyline) change to
squares with borders (@ ).

ﬁ@\

Moving a vertex of a
polygon (polyline)
horizontally or
vertically

1. Click the button.

2. Click on the polygon (polyline).

3. Hold down the [Shift] key and drag the vertex (Il ) up, down,

or to the left or right.

Adding a vertex to a
polygon (polyline)
. Click the [fix ] button.

2. Click on the polygon (polyline).

3. Move the mouse pointer over a line of the polygon, then click.
A (O) appears where the point will be added.

4. From the [Shape] menu, click [Insert Vertex].

You can also double-click on a line in a graphic and add a
vertex.

Deleting a vertex of
a polygon (polyline)
1. Click the || button.

2. Click on the polygon (polyline).

3. Click on the point.
The selected point changes to a square with a border ([ ).
To delete two or more points at the same time, hold down the
[Shift] key as you click on each point ( ll ). Alternatively, drag
the mouse over the points to be deleted.

4. From the [Shape] menu, click [Delete Vertex].

16
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3 Hints and Tips

About the origin
point for engraving

The following figure shows the origin point for Dr. Engrave.
The location of the origin point is always at the lower-left point of
the engraving area, and cannot be changed.

File Edit “iew Fomat Shape Layout Help

D L] fl=lm| xx]o, A

Curgor poz. | 466, 107.6  Object center Crirm

Ready v

The origin point for Dr. Engrave coincides with the XY origin
(home position) of the engraving machine.

Changing the
engraving depth

To change the depth of engraving for each object, change the line

(or fill) color.

The depths of the various colors can be set with the driver for the

engraving machine. For more information about how to make the
settings, see the help screens for the driver.

To change an object's line (or fill) color, follow the steps below.

Click the III button.

2. Click on the object to select it.
3. From the [Shape] menu, click [Properties].
The Properties dialog box for the selected object appears.
4. Click the drop-down arrow next to [Color], then click the
desired color.

Colar I- :

[] Related Topics

Text String Properties
Shape Properties
Polygon Properties
Text Box Properties

18
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Arranging plates of
the same size for
engraving at one time

This section describes how to line up cut plates of the same size
on the engraving machine's cutting table and engrave them at one

time.

In this section, four plates measuring 60 mm x 40 mm (2.4 x 1.5
inch) are mounted on a base measuring 150 mm x 100 mm (6 x 4
inch), and the plates are changed to engrave a total of eight plates.
To make it easy to understand, the procedure described here is
broken down into three steps.

Step 1: Make a template file

Step 2: Arrange the plates and enter the text
Step 3: Ready the engraving machine and start engraving

180 mm
(6 inch)
Rl e Rlem
Jane Michaz]
100 mm
(4 inchy - ?ngrpnchj
I Reslisiel FIFalsinel
40 mm (1.5 inch)
Riehard Paul
= I |
| | - ‘G—ED mm—-‘
2 mm ;
(0.2 inchy lmm (2.4 inch)
z (0.7 inch)
f _ﬂ_—

Line depth for
text and graphics:
0.2 mm

\Elase

Step 1: Make a template file

Create the data for a single plate and save it as a template file.

+—— B0 i —
. (2.4 inch) jlmpur’[ed image file
T | =retang —
40 mim == ——FRectangle
(.3 Iﬂih) 4 Text Box

1. From the [File] menu, click [New...].
The [New File] dialog box appears.

2. Click the [Standard] tab, then click [New File].

Standard

Click [Template] to activate it, then click [OK].

i~ Daocument

* Template

The [Template Properties] dialog box appears.
Enter the plate size, then click [OK].
In this example, enter the values shown below.

Size Y |4EI
s IEEIZI

An empty file with no entries is opened.

Click and create the text box shown in the figure.

4 TextBox

Make the settings for the size of the text in the text box, the
font type, and so on.

You can also make the settings after laying out the plates. In
that case, from the [Layout] menu, use [Edit Template]. In
this example, the text settings are made ahead of time.
Choose a text box, then from the [Shape] menu, click [Proper-
ties].

Make the settings for the text size and layout, font type, and
other necessary items, then click [OK].

Normally, you should set the size of the text so that it doesn't
exceed the size of the text box.

Click IEI to make the rectangle shown in the figure.

Rectangle

Import the image file shown in the figure.
For more information, see Importing bitmap data or Using a
scanner to import an object.

EIRelEns] —— mported image file

10. Click and save the file.
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3 Hints and Tips

Step 2: Arrange the plates
and enter the text

Arrange the plates you created in Step 1, then enter the text in the
text box.

180mm — 4

(6 inch)

=IFinlerd =lFilemd

Micha=
100 mm !
{4 inch) 5 rm

=IRalsig T (0.2inch)
Riehard Paul

| |

(0.2 inch) 5 mm
(0.2 inch)

1. From the [Layout] menu, click [Layout Setup].
The [Layout Setup] dialog box appears.
2. Make the settings as shown in the figure, then click [OK].

Enterthe distance hetween
plate's lower-left point and
arigin paint.

Lyousenp ||

Ok, I
Cancel |

Origin ¥ |5 %[5

Spacing ' |5 =15
pacing I I

[Cluantity IB

™ v Cut

Color I- - I

Enter the numher
of plates laid out.

Enter the spacing
hetween adjacent plates.

3. Enter the size of the base where the plates are mounted.
From the [File] menu, click [Print Setup...].
The [Print Setup] dialog box appears.

4. Click [Properties].
The driver's properties open.

5. Enter the size of the base in the engraving area, then click
[OK].
In this example, enter the values shown below.

whidth 1500 4
Length [tooo 4

6. Click [OK] to close the [Print Setup] dialog box.

7. Click the button.

8. Click on the text box and enter the text.
In this example, enter the text shown below.

iEimisnd iRalend
Jemne Michael
—A ]

[Riehard Paul

9. Click [Next] on the layout information bar to display the
second page.

O | | N T

[Mext] button

10. Click on the text box and enter the text.
In this example, enter the text shown below.

ERisiend e
Crerges Emifly

EFmiend ElRmferme]
Jessie Themas

11. Click and save the file.

[[] Related Topics

Importing a text file into a text box
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3 Hints and Tips

Step 3: Ready the
engraving machine
and start engraving

Install a blade and load a workpiece on the engraving machine,
and start cutting.

a mm (0.2 inch)

z

f

HRaknd | | =Rolend
JEne Michasl !
A mm
HRaland | | =Fsland t (02inch)
Riehard Paul

i
\—Hl:ume position ¢4 origin point)

_.ﬁ]_:_z”
Line depth for

text and graphics:
0.2 mm

\—Elase

Install a blade and load a workpiece on the engraving ma-

chine.

Mount the base on the engraving machine's cutting table, and
load the workpiece at the location shown in the figure.
For more information, take a look at the user's manual for the

engraving machine.

amm (0.2 inchn

—=

—

!
amm

h—|

amm 0.2 inch)

t (0.2 inchy

— Workpiece I— Baze

Operate the engraving machine to set Z0 at the surface of the

workpiece.

Also, set the home position (XY origin point) at the lower-left

point of the base.

For more information, take a look at the user's manual for the

engraving machine.

Click the button.

The [Print] dialog box appears.
Make the settings for the blade's movement speed, cutting-in
amount, and other cutting conditions to match the composition
and thickness of the loaded workpiece and the type of blade.

Click [Properties].

The driver's properties open.

11.

12.

Click [Tool] tab.

=57 Speed : Z Speed:
I2 :|l [rornid=] I2 jl [rrimnes]

Enter the feed rate for [X/Y Speed] and [Z Speed].

When the feeding speed is high, processing becomes rough
and flash marks tend to remain on the cut surface. On the other
hand, when the feeding speed is slow, processing takes more
time.

Be careful because a slower feeding speed does not always
result in improved finishing.

Set a feed rate that is optimal for the composition of the
workpiece being engraved as well as the composition and
diameter of the blade.

Z p Position : Cutter

[050 = o)

£ Down Position ;

[020 = [

Zlp
Fosition (£ — —

-
Z Down —— Workpiece

Fosition (£1)

Enter the values for [Z Up Position] and [Z Down Position].

£ Enaraving Fitch :
010

=
= [mmd (Last path)

First cutting path
f Secand path
T
-

Yinrkpiece

Enter the value for [Z Engraving Pitch].

When the cutting-in amount is deeper, the cutting speed
increases, but the cutting-in amount is limited by the quality of
the workpiece. In cases where the required depth can not be
cut at once, repeat cutting several times to depth that does not
breach the limit.

Click [OK] to close the driver's properties.

. Click [OK].

The engraving data is sent to the engraving machine, and
engraving starts.

When output of the first page of engraving data ends, a
message appears to prompt you to change the workpiece.
Make sure the operation of the engraving machine has
stopped, then load a new workpiece on the base. Load the
workpiece in the same location as shown in the figure in 1
above. If necessary, set Z0 at the surface of the loaded
workpiece again.

After loading the workpiece, click [OK].

The second page of engraving data is sent to the engraving
machine, and cutting starts.

[[] Related Topics
Re-engraving a desired plate
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3 Hints and Tips

Dividing a single
plate to create
multiple plates

This section describes how to place a single plate on the engraving
machine's cutting table and engrave a number of plates while
dividing the loaded plate.

In this section, four identical copies of a design measuring 60 mm
x 40 mm (2.4 x 1.5 inch) are engraved on a plate measuring 150
mm x 100 mm (6 x 4 inch).

To make it easy to understand, the procedure described here is
broken down into three steps.

Step 1: Make a template file
Step 2: Arrange the plates and enter the text
Step 3: Ready the engraving machine and start engraving

180 MM ——

(B inch)
— Plate divisian line
Fclend | —Rolend /
100 mm Jane Michazl
{4 inch) _
SRslend | =Relnd | ]
40 mim (1.9 inch)
Riehard Paul l
= 1 [
[
; +—G0 mm—-
mar?&f‘ﬁﬂ"ghm) | (2.4 inchy ‘
z

T _ﬁ_t"z_'q'-:l—F'late thickness:

2.0 mm
Line depth far Division line

text and graphics: depth: 1.8 mm
0.2 mm

Step 1: Make a template file

Create the data for a single plate and save it as a template file.

— GO i —e
. (2.4 inch) Impotted image file
T [ =reena 1
40 mm ——=—2—Fectangle
(1.5 inih} 35— Text Box

1. From the [File] menu, click [New...].
The [New File] dialog box appears.
2. Click the [Standard] tab, then click [New File].

Standard

3. Click [Template] to activate it, then click [OK].

" Document

= Template

The [Template Properties] dialog box appears.

4. Enter the plate size, then click [OK].

In this example, enter the values shown below.

Size Y |4|:I
S IEEI

An empty file with no entries is opened.

5. Click and create the text box shown in the figure.

54— Text Box

6. Make the settings for the size of the text in the text box, the

font type, and so on.

You can also make the settings after laying out the plates. In
that case, from the [Layout] menu, use [Edit Template]. In
this example, the text settings are made ahead of time.
Choose a text box, then from the [Shape] menu, click [Proper-
ties].

7. Make the settings for the text size and layout, font type, and

other necessary items, then click [OK].
Normally, you should set the size of the text so that it doesn't
exceed the size of the text box.

8. Click @ to make the rectangle shown in the figure.

= ——Rectangm

9. Import the image file shown in the figure.

For more information, see Importing bitmap data or Using a
scanner to import an object.

EJRelenc ——— Imported image file

—_

10. Click and save the file.
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3 Hints and Tips

Step 2: Arrange the plates
and enter the text

Arrange the plates you created in Step 1, then enter the text in the

text box.

" 180 mm n
{6 inch)

— FPlate divisian
Roknd | Rolend /_ line

100 rm Jane Michazl
(4 inch)

FRaleind | IRk
Riehard Paul

=

[
margin & mm (0.2 inch)

From the [Layout] menu, click [Layout Setup].

The [Layout Setup] dialog box appears.
2. Make the settings as shown in the figure, then click [OK].

Enter the distance between

plate's lower-left paint and
arigin point.

Loyoutseh |
Qrigin - 7 |3 w5 oK. |
Spacing ¥ |0 %0 Cancel |
e Y P —
{ Color [P -]

Enter the number  Activate to cut - Changesthe color in order

of plates laid out. dividing lines o differentiate the depth of
text and graphics fromthe
depth ofthe dividing line.

Enter the size of the entire plate to be engraved.

From the [File] menu, click [Print Setup...].

The [Print Setup] dialog box appears.

Click [Properties].

The driver's properties open.

Enter the size of the plate in the engraving area, then click
[OK].

In this example, enter the values shown below.

Wwidth [150.0 :I
Length [oo 4

Click [OK] to close the [Print Setup] dialog box.
Click the button.

8. Click on the text box and enter the text.
In this example, enter the text shown below.

ERslend Rzl

Jane Michael

EFolsnd =Ralena
Riehard Paul

9. Click and save the file.

[[] Related Topics

Importing a text file into a text box

Step 3: Ready the
engraving machine
and start engraving

Install a blade and load a workpiece on the engraving machine,
and start cutting.

— Plate division
Finkend | —Rolend / line

Jane Miechaszl

HRsland | E=Fisken
Riehard Paul

&
\— Horme position G0 arigin point

T l_ﬁ]_.‘-;'.-T-_z':'
Line depth far Division line

text and graphics:  depth: 1.8 mm
0.2 mm

1. Install a blade and load a workpiece on the engraving ma-
chine.
For more information, take a look at the user's manual for the
engraving machine.

2. Operate the engraving machine to set Z0 at the surface of the
workpiece.
Also, set the home position (XY origin point) at the lower-left
point of the workpiece.
For more information, take a look at the user's manual for the
engraving machine.

3. Click the | ;] button.
The [Print] dialog box appears.
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3 Hints and Tips

10.

11.

Make the settings for the blade's movement speed, cutting-in
amount, and other cutting conditions to match the composition
and thickness of the loaded workpiece and the type of blade.
Click [Properties].

The driver's properties open.

Click [Tool] tab.

The color of the graphic and text lines is set to black, and the
color of the dividing lines is set to red.

Set different cutting conditions for the respective colors.

Click on a black tab and specify a tool number.

n 1I|Il_2h|i 3U|F
Tools I‘I TI

Enter the feed rate for [X/Y Speed] and [Z Speed].

27 Speed £ Speed :

I2 :|I [rrimn=] I2 j [rorniz]

When the feeding speed is high, processing becomes rough
and flash marks tend to remain on the cut surface. On the other
hand, when the feeding speed is slow, processing takes more
time.

Be careful because a slower feeding speed does not always
result in improved finishing.

Set a feed rate that is optimal for the composition of the
workpiece being engraved as well as the composition and
diameter of the blade.

Enter the values for [Z Up Position] and [Z Down Position].

£ Up Pozition Cutter

[050 & fom)

£ Dawn Pogition :

[020 A [

& Engraving Pitch :
010 = fmm|

Zlp

FPosition (£ — —
Z0— I: _____

Z Down —— YWarkpiece

Fosition (£1)

Enter the value for [Z Engraving Pitch].

First cutting path
Second path
— (Last path)
-

Workpigce

When the cutting-in amount is deeper, the cutting speed
increases, but the cutting-in amount is limited by the quality of
the workpiece. In cases where the required depth can not be
cut at once, repeat cutting several times to depth that does not

breach the limit.

Set the cutting conditions for the dividing lines.
Click on a red tab and specify a tool number.

12. Make the settings for steps 8 through 11.
For [Z Down Position], enter 1.8 mm.
13. To replace the blade while engraving is PAUSE, activate

[Pause for Tool Change].

¥ Pause for Tool Change

14. Click [OK] to close the driver's properties.

15. Click [OK].

The engraving data is sent to the engraving machine, and

engraving starts.

[] Related Topics

Re-engraving a desired plate
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3 Hints and Tips

Re-engraving a
desired plate

This section describes how to re-engrave a desired plate after
laying out and engraving a number of plates.

At such times as when a portion of the engraving is unsuccessful,
or when engraving is carried out without noticing that text entry
has failed, you can select only the unsuccessful plate and carry out
engraving again.

1.
2.

Open the desired file.
Click the page-selection buttons on the layout information bar
to display the page that includes the plate you want to modify.

E I AN

Fage selection buttons

Correct the data.

Click the E button.

Click on the plate to be reworked.

The plate's contour is selected and its color changes to blue.
To choose a number of plates, hold down the [Shift] key as
you click on the plates.

iSoisnd ]
Jane Michael
—e A

Richard Paul

Install a blade and load a workpiece on the engraving ma-
chine.

For more information, take a look at the user's manual for the
engraving machine.

Click the button.

The [Print] dialog box appears.

For [Print range], activate [Pages] and specify the page range
to be re-engraved.

% Pages fron: |2 o |2

Click [OK].
The engraving data for only the specified plate is sent to the
engraving machine, and engraving starts.

Importing a text file
into a text box

This section how to take text data created with a spreadsheet or
database and import it into a text box.

1.

D

10.

11.
12.

13.

14.

Use a spreadsheet or database to make a text file containing
the data to be imported into the text box.

Choose commas or tabs as the field separators. Dr. Engrave
cannot recognize any separators other than these.

For more information, refer to the documentation for the
spreadsheet or database.

Open a template file that contains a text box.

Make the settings for the size of the text in the text box, the
font type, and so on.

You can also make these settings after importing the text. In
that case, from the [Layout] menu, use [Edit Template]. In
this example, the text settings are made ahead of time.
Choose a text box, then from the [Shape] menu, click [Proper-
ties].

Make the settings for the text size and layout, font type, and
other necessary items, then click [OK].

Normally, you should set the size of the text so that it doesn't
exceed the size of the text box.

Click and save the template file.

From the [Layout] menu, click [Layout Setup].

The [Layout Setup] dialog box appears.

Enter the necessary layout information.

It's not necessary to lay out the same number of plates as the
number of records. The number of plates is adjusted to be the
same as the number of records when the records are imported.
Click [OK].

The Template Layout mode is enabled.

From the [File] menu, click [Import Text...].

The [Open] dialog box appears.

Choose the text file you prepared in step 1, then click [OK].
The [Text Import] wizard appears.

Click on the field separator, then click [Next].

Specify the type of field data to import into the text box.
Drag the text in the field over the text box where you want to
import it.

When you're done making the settings, click [Next].

Choose the record to import into the text box.

To import all records, click [Select All].

When you're done specifying records, click [Finish].

The data in the text file is entered in the text box.
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3 Hints and Tips

Speeding up text
engraving

Text that has been changed to stroke characters can be engraved
more rapidly than outline fonts, because the characters are made
up of fewer line segments.

A-A

Choose a text string to convert to stroke characters.

From the [Shape] menu, click [Make Stroke...].

The [Select Stroke Font] dialog box appears.

3. Click the drop-down arrow for [Stroke Font Name] and
choose a font, then click [OK].
To register a new stroke font, click the text box and enter the
name of the new font.

4. The text is laid out on screen as stroke characters.

o =

[] Related Topics

[Format] - [Edit Stroke...] command

Creating shapes (sucn
as circles and squares) With a
vertical/horizontal
aspect of 1:1

To create a shape with a vertical/horizontal aspect of 1:1, such as a

circle or square, drag while holding down the [Shift] key.
This function is not supported when creating text or a polygon.

1. Click the button for creating a rectangle, round rectangle,
circle or ellipse, or star.
2. While holding down the [Shift] key, drag the object.

[] Related Topics

Making an object larger or smaller
Text String Properties [Keep Aspect for input]
Polygon Properties [Keep Aspect for input]

Changing the size
without altering the
centerpoint

To change the size without altering the position of its centerpoint,
hold down the [Ctrl] key and drag an editing point ( Il or A ).

1. Select the object.

2. While holding down the [Ctrl] key, drag a point ( Il or A ).
The size can be freely changed by dragging a square point ( Il
).
The size can be changed while maintaining the shape's vertical
and horizontal aspect by holding down the [Shift] key while
dragging.

The triangular points ( A ) on the left and right can be dragged
to change the horizontal size.

The triangular points ( A ) above and below can be dragged to
change the vertical size.

[] Related Topics

Making an object larger or smaller
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3 Hints and Tips

Starting drawing of a
graphic from a
centerpoint

To create a shape with a shape's start point the centerpoint, drag
while holding down the [Ctrl] key.
This function is not supported when creating text or a polygon.

1. Click the button for creating a square, rounded-corner square,

circle or ellipse, or star.
2. While holding down the [Ctrl] key, drag the object.

[] Related Topics

Creating shapes (such as circles and squares) with a vertical/
horizontal aspect of 1:1

Creating regular
polygons

A regular polygon can be created by first making a circle, then
modifying it.

1. Click the @ button.

2. While holding down the [Shift] key, drag the mouse to create a

circle.

3. Select the circle, then from the [Shape] menu, click [Proper-
ties].
The [Shape Properties] dialog box appears.

4. Drag the [Shape] slider.

You can make any regular polygon having from three sides (an

equilateral triangle) to thirteen. Dragging the slider to the
right-hand edge creates a circle instead of a polygon.

04—
O

Aligning the centers
of a number of
objects

When arranging a text string at the center of a rectangle, or when
create concentric circles, use the [Layout] menu's [Align] com-
mand.

1. Create the objects at any location.

2. Select all of the objects whose centers you wish to align.

3. From the [Layout] menu, click [Align].
The centers of the selected objects are aligned.
If you have selected a number of objects while holding down
the [Shift] key, the objects are overlaid atop the last object you
chose. If you've selected a number of objects by dragging an
area, the objects are overlaid atop the object in the foreground.

SUMMER

[] Related Topics

Moving an object horizontally or vertically
Arranging a number of objects -- Using Snap to Grid
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Arranging a number
of objects -Using
Snap to Grid-

It's possible to use a grid as a guide for placing and sizing objects.
The grid is shown on screen with equal vertical and horizontal
spacing. When Dr. Engrave has just been installed, the grid is not
shown.

To align an object with the grid, from the [View] menu, activate
[Snap To Grid].

Create the object at any location.

At the [View] menu, click [Show Grid] to activate it.

At the [View] menu, click [Snap To Grid] to activate it.
Select the objects one at a time, and move each object toward
the grid at the desired location. The object is automatically
pulled to the grid and aligned.

b .

When the rectangles are aligned with the left-hand edge

Changing the point where an object
snaps to the grid

The snap point is initially at an object's lower left.
To change the snap point, hold down the [Ctrl] key and click on
the desired point.

i &

Click while holding
down the [Cirl] key.

The snap point can be a point around the perimeter of the object
(any of eight points) or a point at the center of the object.

You can use this feature to align a number of objects at their
centers or their upper-right points, for example.

[[] Related Topics

[Grid Setup...] command
Aligning the centers of a number of objects

Pasting a graphic
created with
commercial software

You can copy data created with software such as CoreDRAW!
that uses vector data, and paste the data into Dr. Engrave using the
clipboard. The data pasted in can then be edited just like any
ordinary object.

Conditions for data that can be pasted
- Don't include bitmap data
- Don't fill or apply shading inside shapes
- Set line width to the finest (narrowest) available setting

1. After using a commercial software application to create data,
select the data and copy it.
For information on how to create data with the commercial
software application, refer to the documentation for the
software you are using.

2. From the [Edit] menu, click [Paste].
The copied data appears in Dr. Engrave.
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Using symbols Changing the
oo Measurement System
2?);1:2 St.oafile being edited, or registered with Dr. Engrave for Numeri cal Valu es

Importing a symbol

1. From the [Shape] menu, click [Symbol]. The measurement system used for numerical values depends on
The [Symbol] dialog box appears. the unit setting for Windows in effect when Dr. Engrave starts up.

2. Select the group, then click on the symbol to be added. The settings for Windows can be changed with [Measurement

3. Click [Insert]. System] on the [Number] tab under [Control Panel] - [Regional
The chosen symbol (object) is laid out on screen. Setting].

4. Adjust the size and position of the symbol to be placed. If the measurement system has been changed, Dr. Engrave must be

stopped and restarted for the new setting to take effect.

Registering a symbol

1. Select the object to be registered a symbol.

2. From the [Shape] menu, click [Add Symbol].
The [Add Symbol] dialog box appears.

3. Register the symbol with an appropriate group according to
use or shape.
To create a new group, click [New Group] and enter a name
for the group. When adding the symbol to an existing group,
select the group name with [Group Name].

4. At [Symbol Name], enter a name for the symbol. Then click
[Add].
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Using a scanner to
import an object

An image acquired with a scanner can be imported into Dr.
Engrave and outlined for engraving.

Dr. Engrave supports scanners that comply with TWAIN_32. For
information on connecting the scanner and installing the scanner
driver, please refer to the scanner's documentation.

There are some image whose outlines cannot be extracted. Please
keep the following conditions in mind when creating data.

Conditions for data allowing extraction of clear out-
lines
- Boundaries between two colors should be sharp and well
defined. with no continuous gradations.
Using only the two values of white and black is recommended.
Scanned data for photographs generally contains continuous
gradations, making it unsuitable for outlining.

<Example>

- The scan resolution should be high.
In general, a higher resolution yields outlining of greater
accuracy. The optimal resolution varies according to a shape's
complexity and size when cut. However, it takes longer to
import high-resolution data into Dr. Engrave than low-
resolution data.

<Example>

72 dpi 300 dpi

- The size of the original art being scanned should be the same
as the size when engraving.
Results of engraving that are more attractive than the original
art are not obtained when an image smaller than the engraved
image is imported and then enlarged with Dr. Engrave. To help
ensure attractive results of engraving, start with a larger object
and reduce it to the desired size.

o =

From the [File] menu, click [Select Source...].

Select the driver for the scanner.

If a TWAIN driver and a TWAIN_32 driver are both installed,
select the TWAIN_32 driver.

Load the original document on the scanner.

From the [File] menu, click [Acquire...].

Launch the scanning software. For information on how to do
this, please refer to the documentation for the scanner.

When the scanning is finished, the scanned data is imported
into Dr. Engrave.

The [Preview] dialog box appears.

Check the scanned data in the [Preview] dialog box and click
[OK].

The outlined object appears on screen.

30



3 Hints and Tips

Importing bitmap
data

Dr. Engrave can import image files in Windows bitmap format
(with a file extension of *.bmp), then outline (extract the contours)
of the imported data or paste it as a polygon (polyline). For
information on how to save a file in Windows bitmap format,
please refer to the documentation for the software application.

There are some image whose outlines cannot be extracted. Please
keep the following conditions in mind when creating data.

Conditions for data allowing extraction of clear out-
lines
- Boundaries between two colors should be sharp and well
defined. with no continuous gradations.
Using only the two values of white and black is recommended.
Scanned data for photographs generally contains continuous
gradations, making it unsuitable for outlining.

<Example>

- The scan resolution should be high.
In general, a higher resolution yields outlining of greater
accuracy. The optimal resolution varies according to a shape's
complexity and size when cut. However, it takes longer to
import high-resolution data into Dr. Engrave than low-
resolution data.

<Example>
72 dpi 300 dpi

- The size of the original art being scanned should be the same
as the size when engraving.
Results of engraving that are more attractive than the original
art are not obtained when an image smaller than the engraved
image is imported and then enlarged with Dr. Engrave. To help
ensure attractive results of engraving, start with a larger object
and reduce it to the desired size.

1. From the [File] menu, click [Import...].
The [Open] dialog box appears.

2. Click [Files of type] and select [Windows Bitmap File
(*.bmp)].
A list of files that can be imported is shown. Select the desired
file and click [Open...].

3. The data is read into the preview screen and displayed. Check
the contents and click [OK].
When importing a color image, outlining may not proceed as
expected, depending on the colors. In such cases, drag the
[Adjust Image Density] slider to adjust the image, or refer to
the "Conditions for data allowing extraction of clear outlines"
to correct the data using a commercial software application.

4. The outlined object appears on screen.

[] Related Topics

[Import...] command
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Toolbar buttons

The toolbar is provided with buttons for running Dr. Engrave
commands such as [Open...] and [Save]. Moving the mouse
pointer over a button displays a brief description of the button's

function.
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This creates a new file.

This opens a Dr. Engrave file.

This saves the file, overwriting the previous
version of the file.

This takes the engraving data displayed on the edit
screen and outputs it to the engraving machine.

This deletes the selected object, and copies it to
the clipboard.

This copies the selected object to the clipboard.

This copies the contents of the clipboard, pasting
them at the selected on-screen location.

This selects an object.

This is used to reposition the vertices of a polygon
(polyline), changing its shape.

This enlarges or reduces the view of the object.

This is used to enter a block of text to be engrave.

This is used to create a square or rectangle by
dragging to the desired location.

This is used to create a square or rectangle with
rounded corners by dragging to the desired
location.

This is used to create a circle or ellipse by
dragging to the desired location.

123

-
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This is used to create a star by dragging to the
desired location.

This creates an open polygon (polyline) by
clicking on vertices.

This creates an entry frame for text.

This command is available only when editing a
template file

This converts the selected text string to stroke

characters.

This performs flat-drag engraving of the interior of
a graphic or text.

The selected object is moved to the front.

The selected object is moved to the back.

The selected block text of text changes to a
horizontal layout

The selected block text of text changes to a
vertical layout.
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Commands - [File]
menu

[File] - [New...] command

This creates a new file.

Clicking the toolbar button creates a new document file empty of
graphics or text strings. At the [File] menu, clicking [New]
displays the [New File] dialog box.

If changes made to a file being edited have not been saved, a
dialog box asking if you wish to save the changes is displayed.
= Keyboard shortcut: [Ctrl]+[N]

[New File] dialog box

(1) Standard I
Presview
3)
& Document (4)
' Template (5)
Qg I Cancel |

(1) Tab

The tab shows the group name for the template file.

The template files (*.det) in Dr. Engrave's [Template] folder
appear on the [Standard] tab.

To add a new group, create another folder one level below the
[Template] folder. The name of the folder you've created uses
the tab name (group name) without change. Note that folders
two or more levels below the [Template] folder are not
displayed.

(2)

This displays a list of the template files included on the tab
you selected.

To create a new file empty of graphics or text strings, at the
[Standard] tab choose [New File].

To create a new document file (*.ded), make [Document]
active. To create a new template file (*.det), make [Template]
active.

(3) Preview
This displays the contents of the template file you've selected.

(4) Document

This copies the contents of the selected template file and
creates a new document file.

To create a new document file (*.ded) empty of graphics or
text strings, at the [Standard] tab choose [New File].

(5) Template

This copies the contents of the selected template file and
creates a new template file.

To create a new template file (*.det) empty of graphics or text
strings, at the [Standard] tab choose [New File].

[File] - [Open...] command

This opens a Dr. Engrave file.

Running this command opens the [Open] dialog box.

If changes made to a file being edited have not been saved, a
dialog box asking if you wish to save the changes is displayed.

= Keyboard shortcut: [Ctrl]+[O]

[File] - [Save] command

This saves the file, overwriting the previous version of the file.
To save the file with a different name or in a different area, use the
[Save As...] command.

= Keyboard shortcut: [Ctrl]+[S]

[File] - [Save As...] command

This saves the file with a different name.
Running this command opens the [Save As] dialog box.

[File] - [Import...] command

This imports a file created using another software application.
Running this command makes the [Open] dialog box appear.

[[] Related Topics

Importing bitmap data
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[File] - [Import Text...] command

This imports a comma- or tab-separated text file into a text box.
This lets you make use of files made using a spreadsheet or a
database that can export data in text format.

This command is available only when multiple plates have been
laid out.

Running this command displays the [Open] dialog box.

Choose a file and click [OK] to call up the [Text Import] wizard.
Follow the messages that the [Text Import] wizard shows to
complete the procedure.

[] Related Topics

Importing a text file into a text box

[File] - [Select Source] command

This selects the scanner connected to the computer.

Dr. Engrave supports scanners that comply with TWAIN_32. For
information on connecting the scanner and installing the scanner
driver, please refer to the scanner's documentation.

If a TWAIN driver and a TWAIN_32 driver are both installed,
choose the TWAIN_32 driver.

[] Related Topics

Using a scanner to import an object

[File] - [Acquire...] command

This takes in the image from the scanner.

The acquired image is outlined and converted to graphics.
Running this command launches the software for performing
scanning. For more information on operation, please refer to the
scanner's documentation.

[] Related Topics

Using a scanner to import an object

[File] - [Print...] command

This takes the engraving data displayed on the edit screen and
outputs it to the engraving machine.

Running this command opens the [Print] dialog box. To output
data, then for [Printer], click on the down-pointing arrow next to
[Name], then click on the driver to be used for output.

At the [Print] dialog box you can make settings for the items such
as the printing range and number of copies.

To make settings for the engraving area (workpiece size) or the
cutting conditions (tool speed, depth, and so on), click [Proper-
ties]. For more information on the Properties settings, refer to the
help screens for the driver.

=Keyboard shortcut: [Ctrl]+[P]

[File] - [Print Preview] command

This displays what the results of printing will look like, so you can
check your work before actually performing printing.

Running this command changes the display from the object's edit
screen to the preview screen.

Preview screen commands

Print... This performs printing. The [Print] dialog box
appears.

Page Setup... This allows you to make settings for paper
size, margins, and the like. The [Page Setup]
dialog box appears.

Zoom In This enlarges the view size of the print image.
Zoom Out This reduces the view size of the print image.
Close This closes the Preview screen for printing.

[File] - [Print Setup...] command

This is used to select the driver.

The [Print Setup] dialog box appears. To output data, then for
[Printer], click on the down-pointing arrow next to [Name], then
click on the driver to be used for output.

To make settings for the engraving area (workpiece size) or the
cutting conditions (tool speed, depth, and so on), click [Proper-
ties]. For more information on the Properties settings, refer to the
help screens for the driver.

The settings made here are temporarily saved. The changes are
lost when you quit Dr. Engrave.
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[File] - [Preferences...] command

This sets the default font and text height when entering text, the
screen color scheme, and the zoom ratio.
Running this command displays the [Preferences] dialog box.

[Preferences] dialog box

(1) — {+ Text " Text Box

Taxt

(2) T Heieht 2 By
i« Sh
I = J el L o el )
Black, d
e |~
Zoom Ratio |1DEI —_

L
—_—
o »
2

(4) ——Font I']I‘F\nal

|
3

(1)
This chooses the default settings of the text string or the
default settings of the text box.

(2) Text Height
This is for entering the default value for text height.

(3)
Choose the portion of the text for which you want to enter the
height.

(4) Font

This sets the default font used when entering text.

(5) Sheet color

This determines the color of the engraving area.

To specify a color other than one of the selections shown,
click [Other]. This displays the [Color] dialog box.

(6) Background color

This determines the background color for the engraving area.
To specify a color other than one of the selections shown,
click [Other]. This displays the [Color] dialog box.

(7) Zoom ratio
This determines the zoom ratio used when Dr. Engrave starts.

[File] - [Exit] command

This ends the program.
If changes made to the file being edited have not been saved, a
dialog box asking if you wish to save the changes is displayed.

= Shortcut:

Click the button for closing the application window.
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Commands - [Edit]
menu

[Edit] - [Undo] command

This erases the change just made and returns to the previous form.

~ Keyboard shortcut: [Ctrl]+[Z]

[Edit] - [Redo] command

This cancels an [Undo] command that has just been run.

~ Keyboard shortcut: [Ctrl]+[ Y]

[Edit] - [Cut] command

This deletes the selected object, and copies it to the clipboard.
The contents of the clipboard are maintained until another object
is copied to the clipboard. To paste the clipboard contents, run the
[Edit] - [Paste] command.

~ Keyboard shortcut: [Ctrl]+[X]

[Edit] - [Copy] command

This copies the selected object to the clipboard.

The contents of the clipboard are maintained until another object
is copied to the clipboard. To paste the clipboard contents, run the
[Edit] - [Paste] command.

~ Keyboard shortcut: [Ctrl]+[C]

[] Related Topics
Copying an object

[Edit] - [Paste] command

This copies the contents of the clipboard, pasting them at the
selected on-screen location.

~ Keyboard shortcut: [Ctrl]+[ V]

[] Related Topics
Copying an object

[Edit] - [Delete] command

This deletes the selected object.
The deleted object is not copied to the clipboard.

~ Keyboard shortcut: [Delete]

[Edit] - [Select All]] command

This selects all objects displayed on screen.

~ Keyboard shortcut: [Ctrl]+[A]
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Commands - [View]
menu

[View] - [Zoom] - [Zoom In] com-
mand

This displays an enlarged view of the object.

= Keyboard shortcut: [Ctrl]+[Page Down]

[View] - [Zoom] - [Zoom Out]
command

This displays an reduced view of the object.

= Keyboard shortcut: [Ctrl]+[Page Up]

[View] - [Zoom] - [Custom...]
command

This specifies the ratio for enlarging or reduced the view of the
object.

Running this command opens the [Zoom Setup] dialog box.

To set the zoom ratio used when Dr. Engrave starts, from the [File]
menu, click [Preferences].

= Keyboard shortcut: [Ctrl]+[Page Up]

[Zoom Setup] dialog box

ZoomSewp 3|
4 ] I
Cancel |

(1) £o0m I'“:”:I

(1)
Enter the view ratio as a percentage.
Any integer from 1 to 800 can be entered.

(@)
Dragging this slider up or down changes the view ratio.
Any integer from 1 to 800 can be entered.

[View] - [Fit to Screen] command

This command expands or reduces the size of the object shown to
fill the screen.

[View] - [Toolbar] command

This toggles the display of the toolbar on or off.

The toolbar is provided with buttons for running Dr. Engrave
commands such as [Open...] and [Save]. Moving the mouse
pointer over a button displays the button's name.

Toggling off the display of the toolbar enlarges the area of the edit
screen.

[[] Related Topics

Toolbar buttons

[View] - [Object Info.] command

This toggles the display of the object information bar on or off.
The object information bar shows the position of the mouse
pointer, as well as the object's centerpoint, dimensions, angle, and
slant.

Toggling off the display of the object information bar enlarges the
area of the edit screen.

[View] - [Status Bar] command

This command toggles display of the status bar window on or off.
The status bar shows helpful comments amount commands. We
recommend leaving the status bar on until you're familiar with
how Dr. Engrave works.

Turning off the status bar enlarges the object's display area.

[View] - [Layout Info.] command

This displays or hides the layout information bar.

The layout information bar shows the position of the lower-left
point (start point) of the plate laid out at the lower left, the spacing
of adjacent templates, the presently displayed page, and the page
feed buttons.

You can display or hide the layout information bar only when
more than one plate is laid out. At this time, the object informa-
tion bar does not appear.

Turning off the layout information bar enlarges the object's display
area.

38



4 Commands

[View] - [Guide Lines] command

This displays or hides the guide lines.
You can display or hide the guide lines only when more than one
plate is laid out.

Using the guide lines, you can make these settings with the mouse:

The position of the lower-left point (start point) of the plate
laid out at the lower left
The spacing between adjacent plates.

[View] - [Show Grid] command

This toggles the display of the grid on or off.

[View] - [Snap To Grid] command

When this is on, objects are automatically aligned with the grid
lines.

Alignment with the grid lines can make it easier to arrange two or
more objects are make settings for object size.

When Dr. Engrave has just been installed, this function is off.
The snap point is initially at an object's lower left.

To change the snap point, hold down the [Ctrl] key and click on
the desired point.

i &

Click while holding
down the [Cirl] key.

The snap point can be a point around the perimeter of the object
(any of eight points) or a point at the center of the object.

[View] - [Grid Setup...] command

This makes the settings for grid interval, whether the grid is
displayed, and whether the snap to grid function is on or off.
Running this command displays the [Grid Setup] dialog box.

[Grid Setup] dialog box
— Interval
QK
(1) ——— Harizantal |5 i ITll
(2) Wertical |5 !

(8) ——TI"/ Shaw Girid " Line (5)
(4) —— 1T Gnap To Grid v Paint (6)

(1)
Enter the interval for horizontally adjacent grid lines.
When Dr. Engrave has just been installed, this is set at 5.0 mm

(0.197 inch).
Setting range: 0 to 100 mm (O to 4 inch)

[] Related Topics

Changing the Measurement System for Numerical Values
(2)

Enter the interval for vertically adjacent grid lines.

When Dr. Engrave has just been installed, this is set at 5.0 mm
(0.197 inch).

Setting range: 0 to 100 mm (O to 4 inch)

[[] Related Topics
Changing the Measurement System for Numerical Values

3)

This toggles the display of the grid on or off.

(4)
This toggles the function for snapping objects to the grid on or
off.

()

The grid is shown with dotted lines.

(6)

The grid is shown with unbroken lines.
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Commands -
[Format] menu

[Format] - [Font...] command

This is used to select the font for a block of text.

Running this command opens the [Font Select] dialog box.

When a block of text has been selected, this command sets its font.
When no text is selected, this command sets the font used when
test is entered.

To set the default font used when entering text, from the [File]
menu, click [Preferences].

[Font Select] dialog box

Font Select E

Arial Rounded MT Bolc Cancel |

BankGothic Md BT
Benguiat Bk BT
BemhardFashion BT
Bembardiod BT

Bremen Bd BT
Charlezwarth LI

adfzs (3)

(1)

This displays the selected font.

Choosing a font from the font list makes the display change.
Clicking [OK] changes the font setting to the one displayed
here.

(@)

This displays the fonts available for selection. Click on a font
in the list to choose it.

Dr. Engrave can use TrueType fonts registered with Windows
as well as stroke fonts that you create yourself.

(3)

This displays the form of the selected font.

[Format] - [Style] command

This specifies a style (bold or italic) for a text string.
To specify a setting other than line width or slant, click [Other].
The Text String Properties or Text Box Properties screen appears.

[Format] - [Direction] command

This setting determines whether the selected text is written
vertically or horizontally.

[Format] - [Line Alighment] com-
mand

You can center a text string or align it with the left margin, the
right margin, or both (justified).

Also, for a text box, you can attach text above or below the box.
You can also lay out text with proportional spacing in a text box.
You can also make the settings from the Text String Properties or
Text Box Properties screen.

[Format] - [Line Spacing] command

This specifies the spacing between adjacent lines.

To specify a line spacing other than one of the available selections,
click [Other]. The Text String Properties or Text Box Properties
screen appears.

[Format] - [Character Spacing] com-
mand

This specifies the spacing between adjacent characters.

To specify a character spacing other than one of the available
selections, click [Other]. The Text String Properties or Text Box
Properties screen appears.

[Format] - [Make Stroke...] com-
2 mand

This converts the selected text string to stroke characters.

This extracts the centerlines of the characters and creates stroke
characters.

Running this command displays the [Select Stroke Font] dialog

'

Depending on the font, stroke characters may not be correctly
aligned in horizontal rows or may not be converted to the
character's originally designed line segments. In such cases, use
the [Format] - [Edit Stroke...] command to correct the shape of
the stroke characters.

[Select Stroke Font] dialog box
(1) Stroke Font Name

Select Stroke Font

Stoke Font Name

M _I ;I Cancel

gl

Choose a stroke font.
To create a new stroke font, enter the font name in this text
box.
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[Format] - [Edit Stroke...] command

This corrects the shape of stroke characters.

This starts the program for editing stroke characters (SFEdit). The
first character of the selected text string appears on the edit screen.
For more on how to use SFEdit, See "Appendixies -Operating
Procedures of SFEdit-".

[Format] - [Properties...] command

This is used to change the attributes and size of a text string or text
box using numerical values.

When you've selected a text string, the Text String Properties
screen appears. When you've selected a text box, the Text Box
Properties screen appears.
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Commands - [Shape]
menu

[Shape] - [Properties...] command

This is used to change the form of an object by modifying its
numerical values.

A dialog box for changing the shape appears. The items displayed
vary according to the type of object selected.

Selecting a polygon (polyline) with three or more vertices displays
the [Polygon Properties] screen. When there are two vertices, the
[Straight Line Properties] screen appears.

To open the properties of a template, then while editing a template
file, make sure no object is currently selected, and run this
command.

Text String Properties
Shape Properties
Polygon Properties
Straight Line Properties
Text Box Properties
Template Properties

= Keyboard shortcut: [Alt] + [Enter]

[Text String Properties] dialog box

'-_ operties 9

(1) —— ek -|_ ©)

(2) Height W J Cancel |
(3) Width [44.69 |-= === (1 O)
(4) Azpect |1— ¥ Keep Aspect for mput & il _TI = (1 1)
(5) frele I | Slant 0 — 3 o g g
(6) CQ‘ﬁ:faaccltr?gr f Font [T Arial =1 (14)
(7) Specme [ Boldnsss Hormal J """"" Bold (15)
Ciolor Iﬁ_— (:Il 6)

——— [ Fill

(8) a SSd [ Bitch r I Oontour+— g‘lg
——(19)

(1) Text Height

Enter the height of the text.

The setting immediately affects all characters in the text string.
Changing this value also makes the [Height] value change
accordingly.

[] Related Topics

Changing the Measurement System for Numerical Values
(2) Height

Enter the overall height for the text string.

Changing this value also makes the [Text Height] value
change accordingly.

[] Related Topics

Changing the Measurement System for Numerical Values

(3) Width

Enter the overall width for the text string.

[] Related Topics

Changing the Measurement System for Numerical Values

(4) Aspect

Enter the size as a ratio, with the vertical/horizontal aspect
(vertical/horizontal ratio) when the text or shape was created
as 1.

Entering a number changes the width without varying the
height. Enter 2 to double the width. Enter 0.5 to halve it.

(5) Angle

Enter the angle of rotation for the object.

The unit is in degrees.

A negative angle may also be entered. Entering a negative
angle rotates the object clockwise.

(6) Character Spacing

Enter the pitch (interval) for adjacent characters. Character
size does not change.

Changing this value also makes the [Width] value change
accordingly.

(7) Line Spacing

This specifies the spacing between adjacent lines.

(8)

This shows the shape of the text.

(9)
Choose the portion of the text for which you want to enter the
height.

(10) Keep Aspect for input

This causes an object's aspect to be maintained at a fixed value
when a numerical value is are entered for Height or Width.
When a value is entered for Height (or Width), the value of
Width (or Height) changes automatically.

(11) Line Alignment
You can center a text string or align it with the left margin, the
right margin, or both (justified).

(12)
This setting determines whether the selected text is written
vertically or horizontally.
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(13) Slant

Enter the degree of slant of the object.

The unit is in degrees.

Entering a positive angle makes the object slant to the right.
Entering a negative angle makes the object slant to the left.

(14) Font

This displays the name of the selected font.

To change the font for the text, click on the down-pointing
triangle.

(15) Boldness

Dragging the slider changes the thickness (weight) of text.

A font cannot be made narrower than its standard weight. The
left-hand end of the slider is standard weight, and the right-
hand end is maximum weight.

(16) Color

Choose the line color of the text or shape.
When [Fill] is on, this changes to the fill color.

[] Related Topics
Changing the engraving depth

(17) Fill
When on, the interior of the object (text or shape) is engraved
by flat-drag cutting.

The route along which the tool moves (the tool path) is created
along the contours of the object. Set the tool-path pitch with
[Pitch].

The tool path is created on the inner side of the object. To
engrave an object's contour lines, select [Contour].

— Pitch

[—1

(18) Contour
After flat-drag engraving of the object finishes, the object's
contours are engraved.

(19) Pitch

This sets the fill pitch (the spacing between adjacent tool
paths).

Normally you should enter the diameter of the blade installed
on the engraving machine. To ensure an attractive finish for
flat-drag engraving, the pitch is generally set at a value smaller
than the blade diameter.

— Pitch

[—]

[[] Related Topics

Changing the Measurement System for Numerical Values

[Shape Properties] dialog box

Shape Properties 10
) Width [22.95 Height [o0.a3 [ oK | (10)
) Angle |D Slal!t |D Cancel |
) Twist ID— Faundscarner Radiie
) color [N ’7 v B % [B11 q__ (12)
) e O | 00 %
) Shape .“I;H]—‘H”””m””””” 1
) I Fil (13
) — Fitch |D1— ™| Gantaur
) |
(1) Width

Enter the object's width.

[] Related Topics

Changing the Measurement System for Numerical Values

(2) Angle

Enter the angle of rotation for the object.

The unit is in degrees.

A negative angle may also be entered. Entering a negative
angle rotates the object clockwise.

(3) Twist

This rotates the center of the star without change the positions
of the vertices.

Enter the angle of rotation. The units of measurement are
degrees.

Entering a positive value rotates the star counterclockwise.
Entering a negative value rotates it clockwise.

This can be used only with stars.

)

(4) Color

Choose the line color of the text or shape.
When [Fill] is on, this changes to the fill color.

[] Related Topics
Changing the engraving depth

(5) Form
Choose the type of shape.

(6) Shape

Drag the slider to change the shape of the object.

Depending on the type of shape you chose, the way the shape
changes may vary.

43



4 Commands

(7) Fill
When on, the interior of the object (text or shape) is engraved
by flat-drag cutting.

The route along which the tool moves (the tool path) is created
along the contours of the object. Set the tool-path pitch with
[Pitch].

The tool path is created on the inner side of the object. To
engrave an object's contour lines, select [Contour].

— Pitch
(8) Pitch
This sets the fill pitch (the spacing between adjacent tool
paths).

Normally you should enter the diameter of the blade installed
on the engraving machine. To ensure an attractive finish for
flat-drag engraving, the pitch is generally set at a value smaller
than the blade diameter.

— Pitch

[—]

[[] Related Topics

Changing the Measurement System for Numerical Values

(9) Contour
After flat-drag engraving of the object finishes, the object's
contours are engraved.

(10) Height
Enter the object's height.

[] Related Topics

Changing the Measurement System for Numerical Values

(11) Slant

Enter the degree of slant of the object.

The unit is in degrees.

Entering a positive angle makes the object slant to the right.
Entering a negative angle makes the object slant to the left.

(12) Round-corner Radius
Enter the corner roundness for a rounded-corner rectangle.

[] Related Topics

Changing the Measurement System for Numerical Values

(13)
This shows the shape of the graphic.

1
2
3

(
(
(
(4

[Polygon Properties] dialog box

*olveon Properties

(5)
) Wfidth 61.56 Hellght Ja023 014 I (6)
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(1) Width

Enter the object's width.

[] Related Topics

Changing the Measurement System for Numerical Values

(2) Angle

Enter the angle of rotation for the object.

The unit is in degrees.

A negative angle may also be entered. Entering a negative
angle rotates the object clockwise.

(3) Aspect

Enter the size as a ratio, with the vertical/horizontal aspect
(vertical/horizontal ratio) when the text or shape was created
as 1.

Entering a number changes the width without varying the
height. Enter 2 to double the width. Enter 0.5 to halve it.

(4) Color

Choose the line color of the text or shape.
When [Fill] is on, this changes to the fill color.

[] Related Topics
Changing the engraving depth

(5) Height
Enter the object's height.

[[] Related Topics

Changing the Measurement System for Numerical Values

(6) Slant

Enter the degree of slant of the object.

The unit is in degrees.

Entering a positive angle makes the object slant to the right.
Entering a negative angle makes the object slant to the left.

(7) Keep Aspect for input

This causes an object's aspect to be maintained at a fixed value
when a numerical value is are entered for Height or Width.
When a value is entered for Height (or Width), the value of
Width (or Height) changes automatically.
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(8) Fill
When on, the interior of the object (text or shape) is engraved
by flat-drag cutting.

The route along which the tool moves (the tool path) is created
along the contours of the object. Set the tool-path pitch with
[Pitch].

The tool path is created on the inner side of the object. To
engrave an object's contour lines, select [Contour].

— Pitch

[—]

(9) Contour
After flat-drag engraving of the object finishes, the object's
contours are engraved.

(10) Pitch

This sets the fill pitch (the spacing between adjacent tool
paths).

Normally you should enter the diameter of the blade installed
on the engraving machine. To ensure an attractive finish for
flat-drag engraving, the pitch is generally set at a value smaller
than the blade diameter.

— Pitch

[—]

[] Related Topics

Changing the Measurement System for Numerical Values

[Straight Line Properties] dialog box

Straight Line Properties
— Start Paint End Paint
) ¥ [6.33 ¥ [3z08 Cancel |
® 1.4 X |25.493
I I Eolorl- - I——

(1) Start Point
Enter the distance from the line's start point to the origin point.
The start point is the drag starting point when plotting the line.

[] Related Topics

Changing the Measurement System for Numerical Values

(2) End Point
Enter the distance from the line's end point to the origin point.
The end point is the drag ending point when plotting the line.

[] Related Topics

Changing the Measurement System for Numerical Values

(3) Color

Choose the line color.

[] Related Topics
Changing the engraving depth
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[Text Box Properties] dialog box

[Text Box] tab

Text Box properties

Text Box I Teut I

— Layout I Orientation——
)
g ; AaBbYyZz | [ | | Text (10)
| -
3) -
@ ——k (1)
— Origir Size ™ Numberir
v[i328 y[2275 ey
(8) _xla ><|33_35 |ncrease I'I
oK I Cancel |
9)
(1)

This shows the layout of the text string in the text box.

(@)

This lays out a right-a

ligned text string.

AB@\

LText bos

3)

This lays out a horizontally centered text string.

When [Format] - [Direction] - [Horizontal] is selected, you
can make the settings for justification and proportional
spacing. Click the button to cycle through the sequence.
When justification or proportional spacing has been
selected, you cannot enter anything on the [Text] tab for

[Width] or [Character

Spacing].

ABGD [ABCDABGC
Center Justify F'rnpnrtjnnal
spacing

(4)

This lays out a left-ali

gned text string.

‘AB@

LText
(5)

This lays out a top-ali

bos

gned text string.

ABGD

I—Text

box

(6)

This lays out a vertically centered text string.

When [Format] - [Direction] - [Vertical] is selected, you can
make the settings for justification and proportional spacing.
Click the button to cycle through the sequence.

When justification or proportional spacing has been selected,
you cannot enter anything on the [Text] tab for [Height] or
[Character Spacing].

A

= 2 BB 3o
e B 3o

D

FProportional
spacing

Center

(7)

This lays out a bottom-aligned text string.

‘AB@

LText bos

(8) Origin
Enter the distance from the lower-left point of the engraving
area to the lower-left point of the text box.

Text box

[] Related Topics

Changing the Measurement System for Numerical Values

(9) Size

Enter the size of the text box.

‘AB@ E

(10)

Drag to rotate the text box.

(11)

Enter the angle of rotation for the text box.

The units of measurement are degrees.

Entering a positive value rotates the text box counterclock-
wise. Entering a negative value rotates it clockwise.
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(1
@)
(3)
(4)
(5)

(6)

(12) Numberir

Numeric values are automatically entered in the text box.
Enter the starting value in [Initial Value] and the value for
incrementing it in [Increase]. You can also insert a zero in

front of the number for [Initial Value].

As shown in the figure, numbering proceeds from the lower

left to the upper right.

7 8 9

4 8 B

efiolnd  fiolnd ok

1 2 3

* When [Initial Value] = 1 and [Increase] = 1

[Text] tab

Text Box properties

gred =2 e

N

—_ AT O

N O

Teut Bow  Test |
Height [2234 | | 1= [189 -|_| '
.
wfidth [0 —5lant |0 X J
Aspectl‘l ¥ Keendspect fon imput
Character .
Spacingh Fant I']T.-‘-\nal ;I
Line IR
— Spacingh Boldness Marmal ] Bold
Calar I- vl E E
a B bY S CF
y‘ ’7 Riteh ID.'I I | Earitaur
1
ak I Cancel |
(1) Height

Enter the overall height for the text string.
Changing this value also makes the [Text Height] value
change accordingly.

[[] Related Topics

Changing the Measurement System for Numerical Values

(2) Width

Enter the overall width for the text string.

[[] Related Topics

Changing the Measurement System for Numerical Values

(3) Aspect

Enter the size as a ratio, with the vertical/horizontal aspect
(vertical/horizontal ratio) when the text or shape was created

as 1.

Entering a number changes the width without varying the
height. Enter 2 to double the width. Enter 0.5 to halve it.

o~~~ o~ o~ o~ o~ —

NN

(4) Character Spacing

Enter the pitch (interval) for adjacent characters. Character
size does not change.

Changing this value also makes the [Width] value change
accordingly.

(5) Line Spacing

This specifies the spacing between adjacent lines.

(6)

This shows the shape of the text.

(7) Slant

Enter the degree of slant of the object.

The unit is in degrees.

Entering a positive angle makes the object slant to the right.
Entering a negative angle makes the object slant to the left.

(8) Text Height

Enter the height of the text.

The setting immediately affects all characters in the text string.
Changing this value also makes the [Height] value change
accordingly.

[] Related Topics

Changing the Measurement System for Numerical Values

)
Choose the portion of the text for which you want to enter the
height.

(10) Keep Aspect for input

This causes an object's aspect to be maintained at a fixed value
when a numerical value is are entered for Height or Width.
When a value is entered for Height (or Width), the value of
Width (or Height) changes automatically.

(11) Font

This displays the name of the selected font.

To change the font for the text, click on the down-pointing
triangle.

(12) Boldness

Dragging the slider changes the thickness (weight) of text.

A font cannot be made narrower than its standard weight. The
left-hand end of the slider is standard weight, and the right-
hand end is maximum weight.

(13) Color

Choose the line color of the text or shape.
When [Fill] is on, this changes to the fill color.

[] Related Topics
Changing the engraving depth

47



4 Commands

(14)
This setting determines whether the selected text is written
vertically or horizontally.

(15) Fill
When on, the interior of the object (text or shape) is engraved
by flat-drag cutting.

The route along which the tool moves (the tool path) is created
along the contours of the object. Set the tool-path pitch with
[Pitch].

The tool path is created on the inner side of the object. To
engrave an object's contour lines, select [Contour].

— Pitch

[—1

(16) Contour
After flat-drag engraving of the object finishes, the object's
contours are engraved.

(17) Pitch

This sets the fill pitch (the spacing between adjacent tool
paths).

Normally you should enter the diameter of the blade installed
on the engraving machine. To ensure an attractive finish for
flat-drag engraving, the pitch is generally set at a value smaller
than the blade diameter.

— Pitch

[—]

[[] Related Topics

Changing the Measurement System for Numerical Values

[Template Properties] dialog box

Template Properhies

(1) — Siee ¥ |4EI
# IED Cancel

\_H
=
%]

(1) Size

Enter the size of the template.

I
|

| " |

[[] Related Topics

Changing the Measurement System for Numerical Values

[Shape] - [Fill] command

This performs flat-drag engraving of the interior of a graphic or
text.

To engrave an object's contour lines, select [Contour]. When
[Contour] is not selected, the contours of filled objects appear in
gray.

Running this command displays the [Fill Setup] dialog box.

Specitying filling of combined polygons lets you perform flat-drag
engraving between the inner and outer sides, as shown in the
figure.

[] Related Topics

[Combine Polygons] command

[Fill Setup] dialog box

3) W Fil
(1) ——— Pitch [01 [ Contaur
(2) — Color Iﬁ

ik, I
Cancel |

(4)

(1) Pitch

This sets the fill pitch (the spacing between adjacent tool
paths).

Normally you should enter the diameter of the blade installed
on the engraving machine. To ensure an attractive finish for
flat-drag engraving, the pitch is generally set at a value smaller
than the blade diameter.

=— Fitch

[—]

(2) Color

Choose the color of fill lines.

[] Related Topics
Changing the engraving depth
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(3) Fill
When on, the interior of the object (text or shape) is engraved
by flat-drag cutting.

The route along which the tool moves (the tool path) is created
along the contours of the object. Set the tool-path pitch with
[Pitch].

The tool path is created on the inner side of the object. To
engrave an object's contour lines, select [Contour].

=— Pitch

[—]

(4) Contour
After flat-drag engraving of the object finishes, the object's
contours are engraved.

[Shape] - [Move Shape...] command

This specifies an object's position as a certain distance from the
origin point.
Running this command displays the [Moving a Shape] dialog box.

[Moving a Shape] dialog box

Moving a Shape
— Position
——r— oc |
f R T
(1 ) — (l- e Cancel I
é. I (L bl (2)

(1)
Choose which portion of the object is to be used for specifying
the position.

C——

A
¢

| -

When more than one object is chosen, a rectangle enclosing all
the objects is displayed.

f—r—r
ek
o

L .

@)X, Y
This specifies an object's position as a certain distance from
the origin point.

“In

* When the object's center is taken to be the reference point

[7] Related Topics

Changing the Measurement System for Numerical Values

[Shape] - [Mirror] command

This flips an object from left to right, creating a mirror image.

[Shape] - [Convert to Polygon] com-
mand

This changes the attribute for an object other than a polygon to the
attribute for a polygon.

Converting an object to a polygon with this command makes it
possible for you to edit its points (vertices).

Once an object has been converted to a polygon, it cannot be
returned to its original attribute (text, rectangle, rounded rectangle,
circle/ellipse, or star).

[Shape] - [Combine Polygons] com-
mand

A number of objects can be grouped together and united into a
single polygon.

They can then be moved or resized while maintaining the layout
the objects had before they were joined together. The points of an
object polygon that has been joined together in this fashion can be
edited in the same way as an ordinary polygon.

=

Can be treated as
a single object

Specitying filling of combined polygons lets you perform flat-drag
engraving between the inner and outer sides, as shown in the
figure.
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[Shape] - [Break Apart] command

A polygon can be split into individual parts.

Can be treated as
separate object

™,

[Shape] - [Insert Vertex] command

This adds a vertex at the specified location.

= Keyboard shortcut: [Insert]

[[] Related Topics
Adding a vertex to a polygon (polyline)

[Shape] - [Delete Vertex] command

This deletes the selected vertex.

= Keyboard shortcut: [Delete]

[[] Related Topics

Deleting a vertex of a polygon (polyline)

[Shape] - [Connect Vertex] com-
mand

This connects the endpoints of an open polygon (polyline) with a
line.

To connect vertices, choose two open endpoints of a polygon
(polyline), then run this command.

Connecting to the endpoint of a different polygon (polyline)
1. Select the target polygon.

2. At the [Shape] menu, click [Combine Polygons].

3. Select the two endpoints.

4. At the [Shape] menu, click [Connect Vertex].

= Keyboard shortcut: [Alt]+[Insert]

[Shape] - [Server Vertex] command

This severs a polygon (polyline) at a specified location.
To specify the severance point, click on one of the polygon's line
segments or vertices.

= Keyboard shortcut:

[Alt]+[Delete]

[Shape] - [Snap to Vertex] command

This overlays the selected vertex on the closest vertex.

Snapping to the vertex of a different polygon (polyline)

1.

2.
3.
4

Select the target polygon.

At the [Shape] menu, click [Combine Polygons].
Select the vertex to snap to.

At the [Shape] menu, click [Snap to Vertex].
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[Shape] - [Symbols] command [Shape] - [Add Symbol] command

This adds a symbol to the file being edited.
Running this command opens the [Symbol] dialog box.

It is used to register a symbol with a Dr. Engrave object.
Running this command opens the [Add Symbol] dialog box.

[Symbol] dialog box

Group Setup |
Delete Gruop |

T OF
: T
4@ .

(1)
The symbol and group names appear. Click the tab and select
the group.

(@)
The name of the selected symbol is displayed. Entering a
symbol name selects the specified symbol.

@)
A list of symbol names is displayed. Click on the name of a
symbol to select it.

(4)

This deletes the selected symbol.

(%)

This changes the name of the currently selected group.
The [Change Group Name] dialog box appears. Enter the
name of the group in the dialog box.

(6)
This deletes the currently selected group. Any symbols
registered in the group are all deleted as well.

(7)

This adds the selected symbol to the file being edited.

(8)
A list of symbol shapes is displayed. Click on a symbol to
select it.

[Add Symbol] dialog box

Group Mame
(1 ) ISaranes ;I
Symbal Mame Q[‘IQ
(2) ISeed leaf
Sidd Cancel I e _Group |
| |
1

@) (4)

(1)

Select the group where the symbol is to be registered. Click to
display a list of existing group names. To add a new group,
click [New Group].

(@)

Enter the symbol name for the selected object.

(3)

The selected object is registered as a symbol.

(4)

This adds a new group for the symbol. The [New Group]
dialog box appears. Enter the name of the group in the dialog
box.
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Commands -
[Layout] menu

[Layout] - [Layout Setup] command

This lays out multiple templates within the area.

If you want to lay out a template file that's being edited, save the
file before you run this command. After you change to the Plate
Layout mode, you can't save the template file.

Running this command displays the [Layout Setup] dialog box.

[Layout Setup] dialog box

Layout Setup
(1) —Diigin ¥ [0 %[0 oK |
(2) —Spacing ¥ [0 ® [0 Cancel |

@)

[uantiby |1 v (4)
’7 Calar I- -I (5)

(1) Origin

Enter the position of the lower-left point of the plate laid out at
the lower left within the page.

Enter the distance from Dr. Engrave's origin point.

ERglend ElRolsmnd

=G =

Qrigin
L-_

—+

H

—

[] Related Topics

Changing the Measurement System for Numerical Values

(2) Spacing

Set the spacing between adjacent plates.

[] Related Topics

Changing the Measurement System for Numerical Values

(3) Quantity

Enter the number of laid-out templates.

(4) V Cut

Enter the cutting-in amount for the plate outline.

You can engrave a number of plates on a single plate, and after
engraving, separate the plates along the V-cut lines.

The plate size after engraving is reduced by an amount equal
to the V-cut width. To obtain the desired finished plate size,
specify a plate size with the V-cut width already added to it.
The V-cut width may differ according to the blade configura-
tion and cutting-in depth.

To set the V-cut cutting-in depth, set the color of the line.
When on, the plate spacing is set at 0 (zero).

[] Related Topics

Dividing a single plate to create multiple plates
Changing the engraving depth

(5) Color

Choose the color of the V-cut line.

The color shows the cutting-in depth. The depths of the
various colors can be set with the driver for the engraving
machine. For more information about how to make the
settings, see the help screens for the driver.

[] Related Topics
Changing the engraving depth

[Layout] - [Edit Template] command

This changes the contents of an imported template.

Running this command calls up the Template Edit screen.
Changes in the values immediately affect the laid out plates. Note
that the referenced template file does not change.

To go back to the Plate Layout screen, run the [Return to Layout]
command.

[Layout] - [Return to Layout] com-
mand

When editing a template with the [Edit Template] command, this
returns you to the Plate Layout screen.

[Layout] - [Move To Front] com-
mand

This changes the front-back relationship of the objects.
The selected object is moved to the front.

= Keyboard shortcut: [Shift]+[Page Up]
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[Layout] - [Move To Back] com-
mand

This changes the front-back relationship of the objects.
The selected object is moved to the back.

= Keyboard shortcut: [Shift]+[Page Down]

[Layout] - [Align] command

All selected objects are aligned at their centers.
If you have selected a number of objects while holding down the

[Shift] key, the objects are overlaid atop the last object you chose.

If you've selected a number of objects by dragging an area, the
objects are overlaid atop the object in the foreground.

[[] Related Topics

Aligning the centers of a number of objects

Commands - [Help]
menu

[Help] - [Contents] command

This displays the contents page for online help.

[Help] - [About Dr.Engrave...] com-
mand

This displays the version number and copyright information for
Dr. Engrave.
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5 If You Think There's a Problem

If You Think There's
a Problem

Dr. Engrave doesn't
function

Does the computer you're using provide
the correct operating environment for Dr.
Engrave?

Check the condffitions for the Dr. Engrave operating environment
and make sure that the computer offers a suitable environment.

Was the software installed using the
setup program?

The setup program puts the files for Dr. Engrave in the necessary
locations to enable the software to be used under Windows.

Engraving machine doesn't
function

Was the correct port selected for the
printer driver?

The data-output port is set with the printer driver.
Open the driver's properties, and on the [Details] tab, check the
setting for [Print to the following port:].

Is the cable connected?

Switch off the power to the computer and the output device, and
use an interface cable to connect the two devices.

Is the correct type of cable used?

The type of interface cable may vary according to the computer
model. Make the connection with the correct type of cable for the
computer.

Be sure the computer and the output device are both switched off
before attempting to attach or disconnect the interface cable.

Error Messages

XXXXX lllegal Font Select.

The Dr. Engrave file you tried to open contains fonts that are not
registered in Windows. When this happens, a list of substitute
fonts is displayed.

The file may have been made on a machine with a different font
environment, or some fonts may have been deleted from Win-
dows. To reproduce the original image, make sure the necessary
fonts are installed.

Not enough memory.

If insufficient memory occurs during processing, close all other
applications or restart Windows.

If the message about insufficient memory still appears, check the
amount of free space on your hard disk. Windows normally uses a
portion of the hard disk for virtual memory, and it may be that
there is not enough space left on the hard disk. If this is the case,
free up space on the hard disk by deleting unneeded files or
moving them to another disk. If the message about insufficient
memory still appears after doing this, it is recommended that you
increase the amount of memory in your computer.

Could not generate outline.

An outline could not be extracted because of the faint color of data
imported using a scanner or Windows bitmap data imported with
the [Import] command. Adjust the data to a darkness that allows
an outline to be extracted and import the data again.

[] Related Topics

Using a scanner to import an object
Importing bitmap data
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Unexpected file format.

A file opened with the [Open] command, imported with the
[Import] command or imported with the [Import Text] is in a
format that Dr. Engrave does not recognize. Use a file format that
Dr. Engrave can recognize.

File formats that can be imported
Windows Bitmap:

Extension *.bmp ([Import] command only)
CSV:

Extension *.csv ([Import Text] command only)
Text:

Extension *.txt ([Import Text] command only)
Document file of Dr.Engrave:

Extension *.ded ([Open] command only)
Template file of Dr.Engrave:

Extension *.det ([Open] command only)

Base font XXXXX not found. Choose
substitute font or click Cancel and install
selected font.

The stroke font file you're trying to open has a setting for a base
font that's not registered with Windows. The file may have been
created on a machine with a different font environment, or the font
may have been deleted from Windows.

Click [Finish] and install the font in Windows, or click [Substi-
tute] change the setting for the base font.

Clicking [Substitute] allows existing stroke characters to remain
without being regenerated. Note that after a font has been
substituted, the substitute font is used as the base design for
creating stroke characters.

Other symptoms

The stroke characters are not evenly
aligned in a horizontal row.

When horizontal stroke characters are entered, the characters may
not be evenly aligned in a horizontal row.

ABC,

This happens because the spacing between the base line and the
text differs from one character to another. When text is written
horizontally, the base lines of adjacent characters are lined up
along a horizontal line so that there is no unevenness.

Because the character centerlines are extracted and converted to
stroke characters, the spacing between the base line and the
character may become ragged, as shown in the figure.

Base Lines

If this happens, correct the shape of the characters so that the
spacing between the base line and the character becomes uniform.
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The stroke characters are not converted
correctly.

When text is been converted to stroke characters, some text may
not be converted correctly.
Here are some of the main reasons why this may happen.

- The width of the lines forming the characters is uneven.

ak

- The characters are too wide, and the direction of line extension
cannot easily be determined.

=)

- Serifs, balls, and other flourishes may deform the lines.

n*llf@

In such cases, use the [Format] - [Edit Stroke...] command to
correct the shape of the stroke characters.
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Appendixies

Operating Procedures of SFEdit
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(1) Title bar

The file name, base font name and program name are displayed
here.

The window can be moved by dragging the title bar.

(2) Menu Bar

Runs the various commands for SFEdit.

(3) Toolbar
The toolbar is provided with buttons for running SFEdit com-
mands such as [Open...] and [Save]. Moving the mouse pointer

over a button displays a brief description of the button's function.

(4)

The size of the box differs according to the type of base font and
the character. Normally you should create the text so that it fits
inside the box.

(5) Base font text

This is displayed as a rough draft for editing stroke characters.
A base font serves as the design base for a stroke font.

If you don't want to display base font text, set [View] - [Base
Font] to "off."

(6) Stroke characters

All stroke characters are made up of polylines and lines.
You can edit them by adding or deleting vertices, adding line
segments, and so on.

—l

(7) Base line

This is the reference line for lining up a text string horizontally.
When text is written horizontally, the base lines of adjacent
characters are lined up along a horizontal line so that there is no
unevenness.

(8) Popup menu

Clicking the right mouse button within an editing area makes a
menu appear.

You can use this menu to run the following commands.

(9)

When the mouse pointer is moved close to here, the pointer
changes to a diagonal arrow. You can then change the window
size by dragging.

(10) Close button

This ends the program.

If changes made to the file being edited have not been saved, a
dialog box asking if you wish to save the changes is displayed.

(11) Maximize button
This expands the window to fill the screen.

(12) Minimize button

This shrinks the window to a button on the taskbar.
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2 Operation
Procedures

Step1: Choose the text

Choose the character whose shape you want to touch up.

The character you chose appears on the SFEdit editing screen,
where you can reposition vertices, add line

segments, and do other things as well.

1. Click on the toolbar's text-entry box, then enter the text string.

If a text string has already been entered, go to 2 below.

4 [~BC] »

— Text entry box

2. Click the El or El button.

The presently selected character is displayed in reverse video.
Use these buttons to move the reversed portion and select the
desired character.

Step2: Correct the shape of
the character

Use SFEdit's editing features to correct the shape of the character.
This section describes how to move a vertex, add a vertex, and
delete a vertex. For other editing functions, see the explanation
for the particular command.

Moving a vertex

1. Click the button.

2. Click on a polyline (or straight line).
3. Drag the vertex (N ).

*  To select a number of vertices, hold down the [Shift] key
while clicking on each vertex (H ).
Alternatively, drag an area that includes the vertices you want
to select. To move the vertices, drag any one of the selected
vertices (W ).

Adding a vertex

1. Click the button.

2. Click on a polyline (or straight line).
3. Position the pointer over a line, and click.
The location for adding the vertex (@ ) appears.

4. From the [Shape] menu, click [Insert Vertex].

You can also double-click on a line in a graphic and add a
vertex.
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Deleting a vertex

Click the button.

1.

2. Click on a polyline (or straight line).

3. Click on the vertex.
The selected vertex changes to a square with a border ().
To delete two or more vertices at the same time, hold down the
[Shift] key as you click on each vertex (Il ). Alternatively,
drag the mouse over the vertices to be deleted.

4. From the [Shape] menu, click [Delete Vertex].

1 Related Topics

Basic Operations

Step3: Save the file

Save the corrected character to a file.
Saving the file causes the results of the change to immediately
affect the text string referencing this file.

Click the button.

The [Save As] dialog box appears. If you're editing an
existing file, no dialog box appears.
Enter the name of the file and click [Save].

61



Appendixies

3 Basic Operations

Selecting a vertex Canceling the selection of a
1. Clickthebutton. vertex

2. Click on a polyline (or straight line).
3. Click on the vertex. 1. Click the L& button.

The selected vertex changes to a square with a border (@ ). 2. Click on an area other than the selected vertex.

Moving a vertex
When a vertex is chosen, pressing the [Tab] key selects a . .
different vertex. To invert the vertex selection order, hold h O I’IZO nta I Iy O I' Ve I’t I Ca I Iy

down the [Shift] key and press [Tab].
1. Click the button.

2. Click on a polyline (or straight line).
3. While holding down the [Shift] key, drag the vertex (Il ) up,
down, or to the left or right.

Selecting multiple vertices

1. Click the button. .
2. Click on a polyline (or straight line). Add | ng ave rtex

3. Hold down the [Shift] key and click on each vertex (I ).
Alternatively, drag the mouse over the vertices to be selected. .
Y. drag 1. Click the L% button.

2. Click on a polyline (or straight line).
3. Position the pointer over a line, and click.

The location for adding the vertex (@ ) appears.
4. From the [Shape] menu, click [Insert Vertex].

Each selected vertex changes to a square with a border (W ).
To select all the vertices included in a polyline (or straight-
line) shape, hold down the [Ctrl] key as you click on the

L] [ ]

vertex.

r——= You can also double-click on a line in a graphic and add a
vertex.
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Deleting a vertex

Click the button.

Click on a polyline (or straight line).

Click on the vertex.

The selected vertex changes to a square with a border (W ).
To delete two or more vertices at the same time, hold down the
[Shift] key as you click on each vertex (ll ). Alternatively,
drag the mouse over the vertices to be deleted.

From the [Shape] menu, click [Delete Vertex].

Selecting a polyline (or
straight line)

1.

Click the button.

2. Move the mouse cursor to the polyline (or straight line) object

to be selected, and click the mouse.
The symbols B and A appear around the selected polyline (or
straight line).

When a polyline (or straight line) is chosen, pressing the [Ctrl]
and [Tab] key selects a different polyline (or straight line). To
invert the polyline (or straight line) selection order, hold down
the [Shift] and [Ctrl] key then press [Tab].

Selecting multiple polylines

(or straight lines)
1. Click the button.

2. While holding down the [Shift] key, click on each of the
polylines (or straight lines) you wish to select.
Alternatively, drag the mouse over the polylines (or straight
lines) to be selected.

Canceling the selection of a

polyline (or straight line)
1. Click the button.

2. Click on an area other than the selected polyline (or straight
line).

Moving an polyline (or
straight line) horizontally
or vertically

1. Click the button.

2. Click on the polyline (or straight line) to select it.
3. While holding down the [Shift] key, drag the polyline (or
straight line) up, down, or to the left or right.
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Making an polyline larger or
smaller

1.
2.
3.

Click the button.

Click on the polyline to select it.
Change the size of the polyline (or straight line) by dragging
the points (M and A ) that appear around the object.

The size can be freely changed by dragging a square point
(m).

The size can be changed while maintaining the shape's vertical
and horizontal aspect by holding down

the [Shift] key while dragging.

The triangular points ( A ) on the left and right can be
dragged to change the horizontal size.

The triangular points ( A ) above and below can be dragged
to change the vertical size.

Drawing a polyline (or
straight line)

1.
2.

Click the button.

Click on the vertices and draw the polyline (or straight-line)
shape.

To end creation of a polyline shape, double-click on the end
point.

To create straight line, double-click on the second vertex.
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4 Commands

Toolbar buttons

The toolbar is provided with buttons for running SFEdit com-
mands such as [Open...] and [Save]. Moving

the mouse pointer over a button displays a brief description of the
button's function.

The buttons provided on the toolbar are as shown below. Click on
a button's icon to display an explanation of the command.

=a|| This opens a SFEdit file.
L= Running this command opens the [Open] dialog box.

H This saves the file, overwriting the previous version of
Ol | the file.

(1) Text entry box

Enter the text you want to edit.

Select a character by clicking the left or right arrow button or
double-clicking on the character. To edit or

browse line characters that have already been registered, then at
the [Shape] menu, click [Character List].

(2) Arrow buttons

These choose the character you want to edit from the text string in
the text entry box.

The character in the text entry box that is displayed in reverse
video is the presently selected character.

Use these buttons to move the reversed portion and select the
desired character.

This selects a polyline (or straight line).
h.‘ To select a polyline (or straight line), move the mouse
pointer over the polyline (or straight line) and click.
When a polyline (or straight line) is chosen, pressing the
[Ctrl] and [Tab] key selects a different polyline (or
straight line). To invert the polyline (or straight line)
selection order, hold down the [Shift] and [Ctrl] key
then press [Tab].

This cancels an [Undo] command that has just been run.

This cancels an [Undo] command that has just been run.

This shifts the position of a vertex and changes the shape
of a polyline (or straight line).

Clicking this button then clicking overtop the polyline (or
straight line) display's the vertices (Il ). Double-

click on a line to add a vertex.

Drag one of the square pointers ( ll ) to change the
position of the corresponding vertex. Dragging a

vertex to a point near a line or another vertex makes it
snap to the line or vertex. To keep it from snapping,

hold down the [Ctrl] key while dragging. Making the
endpoints of a polyline snap together produces a closed
polygon.

When a vertex is chosen, pressing the [Tab] key selects a
different vertex. To invert the vertex selection

order, hold down the [Shift] key and press [Tab].

This creates a polyline (or straight line) by clicking on
vertices.

To end creation, double-click on the end point. Right-
click or press [Esc] while creation is in progress to
delete a vertex.

To create a line, double-click on the second vertex (end
point).

Clicking this button changes the mouse pointer to the
shape-drawing tool (4 ).

This enlarges or reduces the view of the object.
Clicking the left mouse button show an enlarged view
with the point where clicked at the center. The area to
be enlarged can also be specified by dragging with the
mouse.

Clicking the right mouse button shows a reduced-size
view.

This command expands or reduces the size of the object
shown to fill the screen.
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Commands - [File] menu

[File] - [New] command

This creates new stroke fonts.

A dialog box is displayed for selecting the font to serve as the
design base for the stroke font (the base font).

If changes made to a file being edited have not been saved, a
dialog box asking if you wish to save the

changes is displayed.

= Keyboard shortcut: [Ctrl]+[N]

[Select Base Font] dialog box

(1)

m

Allegro BT -
AmerType MdBT

Arial Rounded MT Bold
AwantGarde BL BT
AvantGarde MABT
BankGothic MdBT

Benguiat Bk BT Aa B beZZ
BemhardFashion BT

BemhardMad BT =l

@) (©)

(1)

This displays the selected font.

To choose a font, click the font name in the list or enter the
font name.

(@)

This displays the fonts available for selection. Click on a font
in the list to choose it.

Only TrueType fonts registered in Windows are displayed.

3)

This displays the form of the selected font.

|

(=~

[File] - [Open...] command

This opens a SFEdit file.

Running this command opens the [Open] dialog box.

If changes made to a file being edited have not been saved, a
dialog box asking if you wish to save the changes is displayed.

= Keyboard shortcut: [Ctrl]+[O]

[Open] dialog box

Loak in: I =5 Rsf I

File name: I |_ Open I

Filez of type: | Roland Stroke Font Gepsfl -
| Cancel

@) (4) (%) (8)

(1)

Choose the area where the file has been saved.

(2)

The folders and files in the [Look in] are displayed.
Double-click on a file to open it. Double-click on a folder to
open it and see the files inside.

(©)

Enter the file name.

4)

Select the type of file.

Only files with the chosen extension are listed. To list all files,
choose "All Files (*.*%)."

(5) [Open] button

If a file in the file list has been selected, click this button to
open the file.

If a folder has been selected, click this button to open the
folder and view its contents.

(6) [Cancel] button
This closes the dialog box.
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=l | [File] - [Save] command

This saves the file, overwriting the previous version of the file.
To save the file with a different name or in a different area, use the
[Save As...] command.

= Keyboard shortcut: [Ctrl]+[S]

[File] - [Save As...] command

This saves the file with a different name.

Running this command opens the [Save As] dialog box.
Windows 95 long file names are supported.

Normally, ".rsf" is used as the file extension.

[Save As] dialog box

Save jn; I = Rst I

File narme: IU tithed |_ Save I

Cancel |

Save az lype: IRc land Stroke Font Bersf) | j

I
@) (4) () (6

1)

Choose the area where the file is to be saved.

To enable selection of the created stroke font with Dr.
Engrave, save the file in the [Rsf] folder.

(@)
The folders and files in the [Save in] are displayed.
Double-click on a folder to open it and see the files inside.

@)

Enter the name for saving the file.

The extension selected for [Save as type] is appended to the
file name.

(4)

Select the extension for the file to be saved.

The file extension helps Windows determine the application
associated with the file. SFEdit files use ".rst"

as their extension. Normally, this should be set to "Roland
Stroke Font (*.rsf)."

(5) [Save] button

This saves the file to the selected [Save in].

(6) [Cancel] button
This closes the dialog box.

[File] - [Exit] command

This ends the program.

If changes made to the file being edited have not been saved, a
dialog box asking if you wish to save the

changes is displayed.

= Shortcut:

Click the button for closing
the application window.
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Commands - [Edit] menu

[Edit] - [Undo] command

This erases the change just made and returns to the previous form.

~ Keyboard shortcut: [Ctrl]+[Z]

[Edit] - [Redo] command

This cancels an [Undo] command that has just been run.

= Keyboard shortcut: [Ctrl]+[ Y]

[Edit] - [Cut] command

This deletes the selected object, and copies it to the clipboard.
The contents of the clipboard are maintained until another object
is copied to the clipboard. To paste the clipboard contents, run the
[Edit] - [Paste] command.

= Keyboard shortcut: [Ctrl]+[X]

[Edit] - [Copy] command

This copies the selected object to the clipboard.

The contents of the clipboard are maintained until another object
is copied to the clipboard. To paste the clipboard contents, run the
[Edit] - [Paste] command.

= Keyboard shortcut: [Ctrl]+[C]

[Edit] - [Paste] command

This copies the contents of the clipboard, pasting them at the
selected on-screen location.

You can only paste SFEdit polylines (or straight lines). Shapes
created with another program cannot be pasted via the clipboard.

= Keyboard shortcut: [Ctrl]+[ V]

[Edit] - [Delete] command

This deletes the selected object.
The deleted object is not copied to the clipboard.

~ Keyboard shortcut: [Delete]

[Edit] - [Select All]] command

This selects all objects displayed on screen.

= Keyboard shortcut: [Ctrl]+[A]
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Commands - [View] menu

QL [View] - [Zoom In] command

This displays an enlarged view of the object.

= Keyboard shortcut: [Ctrl]+[Page Down]

QA [View] - [Zoom Out] command

This displays an reduced view of the object.

= Keyboard shortcut: [Ctrl]+[Page Up]

[View] - [Toolbar] command

This toggles the display of the toolbar on or off.

The toolbar is provided with buttons for running SFEdit com-
mands such as [Open...] and [Save]. Moving the

mouse pointer over a button displays the button's name.

Toggling off the display of the toolbar enlarges the area of the edit
screen.

[] Related Topics

Toolbar buttons

[View] - [Base Font] command

This toggles the display of the base font on or off.

[View] - [Grid] command

This toggles the display of the grid on or off.

The default for grid spacing is 50, both horizontally and vertically.
These values do not correspond to any

measurement unit.

The grid may sometimes not be displayed, depending on the
screen's zoom factor or the grid spacing.

[View] - [Snap To Grid] command

When this is on, polyline and its vertices are automatically aligned
with the grid lines.

Alignment with the grid lines can make it easier to arrange the
position of polyline and vertices.

When SFEdit has just been installed, this function is off.

[View] - [Grid Setup...] command

This makes the settings for grid interval, whether the grid is
displayed, and whether the snap to grid function is on or off.
Running this command displays the [Grid Setup] dialog box.

[Grid Setup] dialog box
2 (1)

[GridSewp || K|

1 trerval
)4
Harizontal IED

— Cancel
YWertical IEEI _

W Show Grid
[~ Shap To Grid

(1)

Enter the interval for horizontally adjacent grid lines.

The default value is 50. This value does not correspond to any
measurement unit.

Setting range: 0—1000

(@)

Enter the interval for vertically adjacent grid lines.

The default value is 50. This value does not correspond to any
measurement unit.

Setting range: 0—1000

3)

This toggles the display of the grid on or off.

(4)
This toggles the function for snapping objects to the grid on or
off.

(5)

The grid is shown with dotted lines.

(6)

The grid is shown with unbroken lines.

u

A [View] - [Fit to Screen]
command

This command expands or reduces the size of the object shown to
fill the screen.
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Commands - [Shape] menu

[Shape] - [Character List...]
command

This displays a list of characters which have been converted to
stroke characters.

Running this command displays the [Stroke Font Table] dialog
box.

[Stroke Font Table] dialog box

6)

(1) (8) (9)
m
| ‘ AR

(7) (
- Edit
IR
Delete |
- Cose |

§ (%] & e

Character

()T TR
A

-1 | L
|

(4

——  Inzert

(1)

A list of characters converted to stroke characters appears.

Double-click to make the character appear on the edit screen.

(2) Character

This displays a character selected from the list of characters.
You can also enter a character and display a registered
character.

(3) Code

This displays the character code (ASCII) of a character
selected from the list of characters.

You can also enter a character code and display a registered
character.

(4)

Select the number system of the character code.

You can select this item when the base font is 1-byte character

font.

(5) [Edit] button
This makes the character selected from the list of characters
appear on the edit screen.

(6) [Insert] button
This adds a character (graphic) chosen from the list of
characters to the text now being edited.

(7) [Delete] button
This deletes a selected character from the list of characters.

(4)

Select the number system of the character code.

You can select this item when the base font is 1-byte character
font.

[Shape] - [Regenerate Stroke
Character] command

This regenerates the stroke character being edited and displays it
on screen.

The stroke character being edited is cleared away and replaced
with a regenerated stroke character.

This is used to redo editing of the character in question from the
very beginning.
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[Shape] - [Stroke Character Batch
Generate...] command

This converts all base-font text to stroke characters.
Running this command displays the [Make Stroke All] dialog box.

[Make Stroke All] dialog box

Make Stroke All

) flphanumenz Tal

Cancel |

& Al Eharacters

(1) Alphanumeric Only

This converts the alphanumerical text of base font to stroke
characters, but don't generates the stroke characters that have
already been converted.

You can select this item when the base font is 2-byte character
font.

(2) All Characters

This converts all base-font text to stroke characters, but don't
generates the stroke characters that have already been
converted.

You can select this item when the base font is 2-byte character
font.

3

This starts to generate the stroke characters.

[Shape] - [Insert Vertex] command

This adds a vertex at the specified location.

= Keyboard shortcut: [Insert]

[[] Related Topics
Adding a vertex

[Shape] - [Delete Vertex] command

This deletes the selected vertex.

= Keyboard shortcut: [Delete]

[[] Related Topics

Deleting a vertex

[Shape] - [Connect Vertex]
command

This connects two selected vertices with a line.

Choose two vertices at the ends of a polyline (or straight line).
You can't run this command if only one

vertex is chosen or if one or the other of the two vertices isn't an
end of a polyline (or straight line).

= Keyboard shortcut: [Alt]+[Insert]

[Shape] - [Sever Vertex] command

This severs a polyline (or straight line) at a specified location.
To specify the severance point, click on the line or vertex.

= Keyboard shortcut: [Alt]+[Delete]

[Shape] - [Snap to Vertex] command

This overlays the selected vertex on the closest vertex.

To snap to the vertex of another
polyline (or straight line)

1. Click the button

2. While holding down the [Shift] key, click the polyline (or
straight line) that contains the vertex you want to snap to, and
click the polyline (or straight line) you want to snap to.
Select the vertex to snap to.

4. From the [Shape] menu, click [Snap to Vertex].

(O8]
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Commands - [Help] menu

[Help] - [Contents] command

This displays the contents page for online help.

[Help] - [About SFEdit...] command

This displays the version number and copyright information for
SFEdit.
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5 Error Messages

Base font XXXXX not found.
Choose substitute font or
click Cancel and install
selected font.

The line-character font file you're trying to open has a setting for a
base font that's not registered with

Windows. The file may have been created on a machine with a
different font environment, or the font may

have been deleted from Windows.

Click [Finish] and install the font in Windows, or click [Substi-
tute] change the setting for the base font.

Clicking [Substitute] allows existing line characters to remain
without being regenerated. Note that after a

font has been substituted, the substitute font is used as the base
design for creating line characters.

Not enough memory

If insufficient memory occurs during processing, close all other
applications or restart Windows.

If the message about insufficient memory still appears, check the
amount of free space on your hard disk.

Windows normally uses a portion of the hard disk for virtual
memory, and it may be that there is not enough

space left on the hard disk. If this is the case, free up space on the
hard disk by deleting unneeded files or

moving them to another disk. If the message about insufficient
memory still appears after doing this, it is

recommended that you increase the amount of memory in your
computer.

File input/output failed.

An error occurs when opening or saving a file.

If the error appears when saving a file

The disk you want to save the file to is write-protected, or the file
you're trying to overwrite is read-only.

Save the file on a disk that isn't write-protected, or change the file
attributes to enable it to be written to.

If the error appears when opening a file

The file you're attempting to open is not in SFEdit file format.
Open an SFEdit file.
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Glossary

Object

This is the collective name for shapes and blocks of text.

Dr.Engrave file

This is a file saved in Dr. Engrave format.

Windows BMP (bitmap)

BMP (Windows bitmap) is a standard graphical file format for
Windows. It can be used to store bitmap data.
All graphics are represented as a collection of dots.

SFEdit file

This is a file saved in SFEdit format. Normally, ".rsf" is used as
the file extension.

TrueType font

This is one type of outline font system that represents text as an
outline and a filled portion. It is provided as standard on Win-
dows.

Vector data

Vector data is a data format that represents images (text and
shapes) as a set of reference points and the lines that connect
them. Most draw-type software applications can be used to create
vector-data images.

Bitmap data

Bitmap data is a data format that represents images (text and
shapes) as a collection of dots. Most paint-type software applica-
tions show images as bitmaps.

Resolution

This is a scale that indicates the precision of images displayed on
screen, printed on the printer, or acquired with the scanner. The
larger the number, the more detailed and attractive is the image it
represents.

Gradations
This indicates the smoothness of changes in color when colors are
used.

Indicate

This indicates the smoothness of changes in color when colors are
used.

Clipboard

The clipboard is used to hold data temporarily when it is being
copied or cut. The clipboard is a standard feature of Windows.

Csv

This is one format for saving data from a database, spreadsheet, or
the like as a text file. Text (or numerals) entered into fields or
cells are exported to a file in comma-separated format.

In addition to the CSV format, which uses commas as separators,
some programs let you specify tabs or spaces as separators.

74



Appendixies

IndeXx

A
[About Dr.Engrave...] command ...........cccceceevieieiienienenenenienenne 53
[About SFEdit...] command ...........cccceeevieeiiieeirieeiieeeieeereeeene. 72
[Acquire...] cOMMANA .........ccceevierieriiniiniiniinieeetetetee e 35
[Add Symbol] command ..........cccceeuevuerinenininiieieienenenesenene 51
[Add Symbol] dialog DOX ...cc.ceeeueriinieniiniiniinieieeeeeeteteiesienieee 51
ALGN e .27, 28
[Align] commMAand .........cccoeereririiienienieneneeeeeeeee ettt 53
ATTOW DULLON ..vtiiiiiieeiieciieeeecit et ete e ete e esae e v e saesaaessaeneeens 65
ASPECL .ttt 26, 42, 44, 47
B
[Base Font] command ..........cccceeeeuieriieeniieniienieeciee e, 69
Base fONE tEXE ..ouviriiiieeieiieeiereese e erteereereeaeeaeeeesaesaeessaeseeens 59
"Base font XXXXX not found." .......c..ccoeeverierienieneereeeeeeen 56
BasSE LINE ..cevviieiiiciieeeeeee e 56, 59
Bitmap data.....cccceceeiiieienieieneeeee e 28, 31, 74
BMP (DItMAP) ....eeuveuieiinienienieniteiteteteste ettt 74
BMP I1E ..ottt 31
[Break Apart] command .........c.ceceeveeruereenuenieeeieieiesieseniesienenee 50
C
[ 1 et USRS 12
Changing the engraving depth ........c.ccocevevererinninnienencneneeee, 18
Changing the measurement SYSteIm .........ccceceeveeruereeerueerreneenennes 29
Changing the pOint SNAPS .....ceceeververierienierienienieneneeeeeesteseeseenes 28
[Character List...] command .............cccoecveeeiereeireeeiieeeieeereeennee. 70
[Character Spacing] command ..........cccceeeveerereneeiesierienienienenne 40
CLPDOATA ..ottt ns 28, 37, 74
ClOSE DULLOM ...ttt ettt eereeeaeeea 7, 59
COAE ..ottt ettt e st et e e be e teebeebeebeesaessaessaessaens 70
[Combine Polygons] command ..........ccceevereereneeneneneneennenes 49
[Connect Vertex] command .............coceeeeveeeieeeeveeeiieeeeieeeenreennen. 50
[Contents] command .............ccceeevveeeieeeieeeieeeeieeeereeeereeeeane 53, 72
[Convert to Polygon] command ............cccecevecereneenecnecniecennene 49
[Copy] cOmMMANA ......ooueriereiriiriiieieieetesesesese e 37, 68
"Could not generate outline." ..........cccoeeveeeeeereeiesienienienenenenne 55
Creating CiIClES .....ccveierierienenienieniteiteteteste ettt 26
Creating regular POLYZONS .......ccccecvevierierierenerenieeeeeiesieseseenes 27
Creating SQUATES ....c..eeververrerrererieieientesiessessesseeseetessessessessessenses 26
CSYV ettt ettt sttt be et ettt b e be b aeene 74
[Custom...] cOMMANd .......c.cceeveievrieerieeeiee e et 38
[Cut] comMmMANd ......c.eeeeviieiiieereeeieeecee et 37, 68
CUtting-in AMOUNE .......cecteierierierieriereneeeeeeeerteee st ereeaes 21, 24
D
Default SELHNES ...c.eeuveierreierieneneeieetet ettt 36
[Delete] command ...........cocueeeeveeeerieeiieeeieeeiee e e 37, 68
[Delete Vertex] command ............cceeeeveeeeuieeeiieeeieeeenieeeeeeeneeenenen 50
Dialog box

[Add Symbol]....

[Fill Setup] ........

[FONt SELECL] ...vviieeieeeeeeeeee ettt e

[Grid SEtuP] ...coeeieiiieierierereteeetee e 39, 69

[Layout SEtupP] ...ccceeveveerereririeieieneenieseeeeeeeeeeenees 20, 23, 52

[Make Stroke AlL] ...coveeeuieeieeeeeeeee e 71

[Moving @ Shape] .....cccccovevueruenenenininieeeieieiestenesesieseenene
[INEW FIIE] ettt
[Polygon Properties] ...
[Preferences] ...............
[Save AS] ueeeeeerneennen.
[Select Base FONT] .....eeiiiiiiiiiieieiee e
[Select StroKe FONt] .....cooovviviieeiiieieeieeee e
Shape Properties..................
[Straight Line Properties] ...
[Stroke Font Table] ............
[SYMDBOI] ..ottt
[Template Properties] ........cccccoevereninineninienieicrenenenenenae
[Text Box Properties] ......
[Text String Properties] ...
[Direction] COMMANA .........cccuvreieeeueeieeeiieee e eeereeeeeeeaeeeeeeaees
Doesn't function
DI ENGIaVve ....ccoooviviiniiniiniiicecicieereeeeececete e
Engraving machine
Dr.Engrave file ......ccoviriiiiiiniininiceeecceeeeeeeees
E
[Edit] MENU ..cvviveeiiiie ettt ettt e 37, 68
[Edit Stroke...] command .........cccccceeeeeeueeeeeeiieeeeeereeeeeeereeeeeenens 41
[Edit Template] command .........cccceceeeeeeieienienenenienieneneneeeens 52
Engraving
CANCEL .o 12
DEPth et 18
Engraving at one time ..... . 19, 22
OFIZIN cevivieiieiieietcteereere ettt ettt sb e 18
Ready ....ccceueeee .21, 23
Specified Plate ......c.coeeeeieeeieriererenenenece e 25
SEATT 1ecvieiecieceeee ettt ettt e e e easeeaeeeteeereeneen 21, 23
ENgraving area .......ccccoeeeverenenenieeeieieieeienenenese e 9, 20
ENter the tEXT .vvvviiiieieeee ettt 20, 23
Error messages ... 73
[EXit] COMMANA ...oooiiiiieiieieieie e 36, 67
Extraction of clear OUtlINES ..........eeeeeuveeeeeieeeeeeeieeeeeeereeee e 30, 31
F
FEed rate ....cccuevieeiieieeieeteeeeete et 21, 24
[FAle] MENU ..ecuiieiiiieieeieeeeeee ettt 34, 66
[Fill] command .........cceeeeeeenieniiieeieeieeeeee et 48
[Fill Setup] dialog boX .....cccceveevieniiniininininieieieiciesesenenenene 48
[Fit to Screen] command ...........cccceeeeeeeeeeeeenneeeeeeeeeeeeeneeen. 38, 69

Flat-drag engraving
[Font...] command

[Font Select] dialog DOX .....cccceoeevveruinieniinininieieicieierenienenene 40
[FOrmMat] IMENU ....vvveiieieeieeeeieeee ettt e eesre e e e ereeeeeennnees 40
G

(€ 2V F:1 5 (o) o TR 30, 31, 74
G ottt ettt et e eae e ve e eane e 28, 39
[Grid] cOMMANA .....coovviiiieiieic e eeaaes 69
[Grid Setup...] command ..........cccceeuevvevienenenieneneneneeieeens 39, 69
[Grid Setup] dialog box 69

[Guide Lines] command ...........ccccceeeeeeveeieeenineeeeeeiieeeeeeneeeeeennnes 39

75



Appendixies

H

[Help] MENU .....ooveiiiiniininiiricieieeecrcnrenenese et 53, 72
|

"XXXXX Illegal Font Select."” ........ccccoevinininineninieieienenenne 55
[Import...] cOMMANd ....c..cocereriiiiiiiiiirintiereeeee et neeee 34
[Import Text...] command ........c.ccoeevuevuenenieenenieiieierenenenenne 35
Importing @ CSV file ....ccooevenininininiiiccccceeee 25, 35
Importing a teXt file .....cocoververiiiiinienininenccceeee 25
Importing an object

Importing bitmap data .......cccceceeevevieneneneninieeeeeeeeeeeeeee 31
INAICALE ..ot et 74
Inporting CSV file ....ccooovivinininininiricicccccceeecee 25, 35
[Insert Vertex] command ..........ccoccueeeeeeueeeeeeieeeeeesreeeeeeinneeeeennnens 50
L

[Layout] MENU ..cc.eoveriereriiiiiieieietetenreereerteterereresre e s seeene 52
[Layout Info.] command ...........cccccouevueniininininininiiienenenenenae 38
[Layout Setup] command 52
[Layout Setup] dialog box 52
[Line Alignment] command .........c.ccoceeeverininineeeeiiecrenienenenne 40
[Line Spacing] command .........cc.ccceevuevuenvininineneeieiecrenienenenne 40
M

[Make Stroke...] COmMmand ...........ccccoeevuvereeeniveeeeeeiieeeeeeeeeeeeeinnes 40
Maximize DULLON ......cccveieiiieciie et 7, 59
Measurement SYSLEIN ......cc.eeereruerrreeenierierensensenseeeeneeeessessensennes 29
MENU DAL .....oiiiiiieiieciece et e 7, 59
Minimize BULLON ......cocviiiiiieiiieeieeeee e e eeae e 7, 59
[Mirror] command

[Move Shape...] command ........c.cccceeveveeieieenrinieesienienenenenenne 49
[Move To Back] command ............eeoeeveeeeeenneeeceeieeeeeeeieeeeeennens 53
[Move To Front] command............ccccoevurreeenineeeieeineeeeeeneeeeeennens 52
[Moving a Shape] dialog BOX .......cccceuervivinieininieieienenenenenae 49
Multiple PIates .......ccevererererinireetetceeereeeeee e 19, 22
N

o)

Object

COPY ettt ettt ettt b et 15

P
PaASTE oo e e 37, 68
[Paste] command .............coceeeeeeeeiieeeiiieeeieeeee e 37, 68
Pasting @ graphicC ......cccceceeeeiriiienienienenerereeeete e 28
[Polygon Properties] dialog BoX .......cceeveeuieieeeienienierienienenenae 44
Polyline
Changing SIZe .......ccceevererererieieieniereneseeeete et 64
DIAWINZ .ottt ettt
IMOVINE vttt sie ettt et s bbbt st ettt e aes
Selecting.....

Popup menu ....
Port ..o

[Preferences...] command ...........cccceeveeeeuieeeiieeeirieeeie e 36
[Preferences] dialog BoX ........ceceeveerienieniinininieieteieiesiesiesieneae 36
PIEVIEW oottt ettt ere e e eaaeeas 35
[Print...] comMmand ...........cccoeeeueeeiiieeiieeeie e 35
[Print Preview] command ............cccooeeeeieeeiieeeinieeeiie e 35
[Print Setup...] command ..........ccocevevuerereninieieieienenesenenene 35
[Properties...] command

[Format] - [Properties...] ...ccoceeveerienienienenininieceeeiesiesiesienne 41
R
RE-ENZIAVING ..ooviiiiiiiiiiiesienteeee ettt
[Redo] command ............coevveerieeineeennneennne..
[Regenerate Stroke Character] command....
ReSOIULION ....ocouvveeiieccieeeieeceeceeeee e
[Return to Layout] command .........cccccecuerieneenieneenennennieneennne.
S
[Save] cOmMMANA ......cccuvviiiiiiieeiieieee e e
[Save As...] command...
[Save AS] dialog DOX ..c..coerverieriiiiiiniiiiiiniieeeeeeeecrcrere e
[Save As...] COMMANG ......coovuveiiieiiieieeieeee e eeaaes
[Save] command ...........
Scanner .........ccceeevveneen.
[Select All] command. .................
[Select Base Font] dialog boX ......cccceceeeeerieieiecienienieneneneneae 66
[Select Source] cOMMANd ........ccovveeeeeirveieeeeireee e eeeeeas 35
[Select Stroke Font] dialog boX .......cceevevvenrieineneniecieienienenenne 40
[Server Vertex] cOMmMANd .........ccceeeeeeeuveieeeeiireeeeeieeeeceeeeeeeeeneens 50
SEFEIL .ottt ettt e et aeeene s 41
SFEIt Il ...uvivvivieeieeete ettt ettt e ve s 74
[Shape] MeNU .......ccccuevierenineninirieieeceeesese e 42, 70
[Shape Properties] dialog BOX ......cccceveeveeerieieiecienienenenenenene 43
[Show Grid] command ...........coeeuveeeeeceeeeeeiieeeeeeree e 39, 69
SNAP POINL c..evviiiiiieiicieieteeeeet ettt ettt sae e 28
[Snap To Grid] command .........cccceceeeeeveeveenienienrenenenenienenne 39, 69
[Snap to Vertex] command ..........ccccecvevuevvenrenenenienienenneeeens 50, 71
SPEEA ettt 21, 24
Starting the SOftWATe .......c.coeverirenirinieicceeeereeeeeeeeeeae 6
Status bar
[Status Bar] command ..............cooouveeeeeiiieieeeieecceeieeeeeeree s 38
Straight line

Drawing

MOVINE ceviviriiieiieteieestesene ettt sttt

Selecting
[Straight Line Properties] dialog boX .......ccceoeeveevecvecierenenienenne 45
[Stroke Character Batch Generate...] command .......................... 71
Stroke Characters .........oocceeeeeevveeeeeevveeeeeineeeens 26, 41, 56, 57, 59
[Stroke Font Table] dialog BOX .....c.ccccvvevvinuininineninieieienenienne 70
[Style] command .......c..cocceveeieniiniininininieeeeeeee e 40

76



Appendixies

Symbol
IMPOTT . 29
REZISLET ..ttt 29
[Symbol] dialog DOX .....ccevuerieririiiiieienieiereeeeeeeetetete e 51
[Symbols] command...........coceeeeeriinieniinieniinieeeeeeetetetesee e 51
T
Template ..o 19, 22
[Template Properties] dialog boxX .......ccccccvveerrerveuennennn 19, 22, 48
[Text Box Properties] dialog bOX .......cccceevverineneninieierienienee 46
Text entry box
[Text String Properties] dialog BoX .......cccceceverereneneeneenens 42, 43
THELE DAL ...ttt e 7, 59
TOOIDAL ...ttt 7, 33, 59
[Toolbar] coOMmANd ..........ccceeueevreerieeciieieeieeee e see e 38, 69
Toolbar buttons 65
TrueTYPE fONL .oveeiiieiieieieieresee et 74
TrueType fonts 10
TWAIN ..ottt 35
U
[Undo] command .............coceeeeeeeeeeeeieeeeeeeeeeeeeeree e e 37, 68
"Unexpected file format.” .........cccceoeevierinininininenieieieiesienene 56
USING SYMDOLS ...t 29
\'
VUCUL ettt 52
VECTOT AALA ..ttt et e e earaeeeeans 28, 74
Vertex
AdAING .ottt
Deleting ...
IMOVINE cnvivivieiieiieicteentesene sttt ettt
SEIECHNG ..ottt ettt

Vertex of a polygon (polyline)

SCIECE ettt ettt s 15
Vertical/horizontal aspect ........coccecevveevenvenerenuennne 26, 42, 44, 47
Vertices of a polygon (polyline)

Selecting all ....c..ooveeiirininiiiiici e

Selecting multiple ....

[VIEW] IMENU ...ttt eeeree e

w

Windows BMP (bitmap) .......cccceceeienieneneneninenieieicienreeneenenes 74
X

"XXXXX Illegal Font Select” ......ccccoeeivinieieiecienienenenenenenne 55
Z

[Zoom In] command ........ccccueveeeeueiiiieiieeieecieeeeeeee e 38, 69
[Zoom Out] command ...........eccovvuereieeieeeeeeeieeeeeereeeeeeneeen 38, 69

77



LJRoland

R2-991220



	Contents
	Introduction 
	Operating environment 
	Overview of Dr.Engrave 
	Starting the software 
	Names and functions of screen items 

	Operation Procedures 
	Introduction 
	Step 1: Enter the workpiece size 
	Step 2: Set the cutting conditions 
	Step 3: Enter the text 
	Step 4: Draw graphics 
	Step 5: Import an image file 
	Step 6: Save the file 
	Step 7: Start engraving 

	Basic Operations for Objects 
	Selecting an object
	Canceling the selection of an object 
	Moving an object
horizontally or
vertically
	Making an object
larger or smaller
	Rotating an object 
	Slanting an object 
	Copying an object
	Deleting an object 
	Selecting a vertex of a polygon (polyline) 
	Selecting multiple vertices of a polygon (polyline) 
	Selecting all vertices of a polygon (polyline) 
	Moving a vertex of a polygon (polyline) horizontally 
	Adding a vertex to a
polygon (polyline)
	Deleting a vertex of
a polygon (polyline)

	Hints and Tips 
	About the origin point for engraving 
	Changing the
engraving depth
	Arranging plates of the same size for engraving at one time 
	Dividing a single
plate to create
multiple plates
	Re-engraving a
desired plate
	Importing a text file
into a text box
	Speeding up text
engraving
	Creating shapes (such
as circles and squares) with a
vertical/horizontal
aspect of 1:1
	Changing the size without altering the centerpoint 
	Starting drawing of a graphic from a centerpoint 
	Creating regular polygons 
	Aligning the centers
of a number of
objects
	Arranging a number
of objects -Using
Snap to Grid-
	Pasting a graphic created with commercial software 
	Using symbols 
	Changing the
Measurement System
for Numerical Values
	Using a scanner to
import an object
	Importing bitmap
data

	Commands 
	Toolbar buttons
	Commands - [File] menu 
	[File] - [New…] command 
	[File] - [Open...] command 
	[File] - [Save] command 
	[File] - [Save As...] command 
	[File] - [Import…] command
	[File] - [Import Text…] command 
	[File] - [Select Source] command 
	[File] - [Acquire...] command 
	[File] - [Print...] command 
	[File] - [Print Preview] command 
	[File] - [Print Setup...] command 
	[File] - [Preferences...] command
	[File] - [Exit] command 

	Commands - [Edit] menu 
	[Edit] - [Undo] command 
	[Edit] - [Redo] command 
	[Edit] - [Cut] command 
	[Edit] - [Copy] command 
	[Edit] - [Paste] command 
	[Edit] - [Delete] command 
	[Edit] - [Select All] command 

	Commands - [View] menu 
	[View] - [Zoom] - [Zoom In] command 
	[View] - [Zoom] - [Zoom Out] command 
	[View] - [Zoom] - [Custom…] command 
	[View] - [Fit to Screen] command 
	[View] - [Toolbar] command 
	[View] - [Object Info.] command 
	[View] - [Status Bar] command 
	[View] - [Layout Info.] command 
	[View] - [Guide Lines] command 
	[View] - [Show Grid] command 
	[View] - [Snap To Grid] command 
	[View] - [Grid Setup...] command

	Commands - [Format] menu 
	[Format] - [Font…] command 
	[Format] - [Style] command 
	[Format] - [Direction] command 
	[Format] - [Line Alignment] command 
	[Format] - [Line Spacing] command 
	[Format] - [Character Spacing] command 
	[Format] - [Make Stroke...] command 
	[Format] - [Edit Stroke...] command
	[Format] - [Properties…] command 

	Commands - [Shape] menu 
	[Shape] - [Properties…] command 
	[Shape] - [Fill] command 
	[Shape] - [Move Shape...] command 
	[Shape] - [Mirror] command 
	[Shape] - [Convert to Polygon] command 
	[Shape] - [Combine Polygons] com-mand
	[Shape] - [Break Apart] command 
	[Shape] - [Insert Vertex] command 
	[Shape] - [Delete Vertex] command 
	[Shape] - [Connect Vertex] command 
	[Shape] - [Server Vertex] command 
	[Shape] - [Snap to Vertex] command 
	[Shape] - [Symbols] command 
	[Shape] - [Add Symbol] command 

	Commands - [Layout] menu 
	[Layout] - [Layout Setup] command 
	[Layout] - [Edit Template] command 
	[Layout] - [Return to Layout] command 
	[Layout] - [Move To Front] command 
	[Layout] - [Move To Back] command 
	[Layout] - [Align] command 

	Commands - [Help] menu 
	[Help] - [Contents] command 
	[Help] - [About Dr.Engrave...] command 


	If You Think There's a Problem 
	If You Think There's a Problem 
	Error Messages 
	Other symptoms 

	Appendixies 
	Operating Procedures of SFEdit
	1 Names and functions 
	2 Operation Procedures 
	Step1: Choose the text 
	Step2: Correct the shape of the character 
	Step3: Save the file 

	3 Basic Operations
	4 Commands
	Toolbar buttons
	Commands - [File] menu 
	Commands - [Edit] menu 
	Commands - [View] menu 
	Commands - [Shape] menu 
	Commands - [Help] menu 

	5 Error Messages 

	Glossary
	Index 


